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Introduction
What Is Microsoft Dynamics CRM?
Microsoft Dynamics CRM is a customer relationship management tool. 
At its very core, Microsoft Dynamics CRM is a database. It’s the place where
you can enter information about your customers: Who works at the company,
what are their roles, who at your company has communicated with them, what
have they purchased, and have they had any issues? Need a phone number?
Looking for a customer’s latest support calls? Need to get a handle on your
sales pipeline? You’ll get all of this and more in Microsoft Dynamics CRM.

Microsoft Dynamics CRM goes way beyond traditional databases, though. 
It has many built-in tools to help manage the interactions you have with your
customers.

There are a lot of CRM systems on the market. Microsoft Dynamics CRM is
the first, however, to fully integrate into Microsoft Office Outlook. All of the
instructions in this book will work both in the Microsoft Dynamics CRM web
application and within Outlook.

For more information on purchasing Microsoft Dynamics CRM go to
http://crm.dynamics.com or call 877-CRM-CHOICE (877-276-2464).
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Creating and deleting leads
Leads are prospects. In many ways, they look and feel like contacts, but they
have one big distinction. You haven’t qualified them yet. You can add new leads
manually, or you can import lists of leads. Then, as the leads go through your
sales cycle, you’ll come to a point where you either disqualify them or convert
them to active customers.

Task A Creating a new lead
At any point, you can enter a new lead into the system manually. Maybe
someone called with an inquiry about your services. Perhaps someone sent an
unsolicited e-mail from a link on your website. Maybe you came back from a
conference with someone’s business card. All of these prospects can be entered
into Microsoft Dynamics CRM as leads.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Sales and then Leads.
2. On the Leads tab of the ribbon,

in the Records group, click the
New button.

3. Enter information about your
lead into the form that appears.

4. On the Lead tab of the ribbon, in
the Save group, click the Save &
Close button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Sales and then Leads.
2. On the Leads menu, click the

New button.
3. Enter information about your

lead into the form that appears.
4. Click the Save and Close button

at the top to save your changes.

When entering a new lead, fields
marked with a red asterisk (*) are
required. Fields marked with a blue
plus sign (+) are recommended.
Some options will not be available
until you save the lead. If something
you’d like to do is grayed out, try
saving the lead.
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Task B Importing a list of leads
Using the Import Data Wizard, you can mass import lists of leads from a
spreadsheet (XML), comma-separated value (CSV) file, delimited text (TXT),
or ZIP file. Importing leads saves a lot of keystrokes, and you can use this saved
time to focus on selling to customers.

Importing is generally a task restricted
to just a few people in your company.
Check with your administrator if
you’re not sure if importing data is
enabled for your user profile.
If the column headers in your import
file are exactly the same as the CRM
Attribute Display names, then the
import will automatically map the
fields for you.

Outlook 2010/Internet Explorer:
1. On the Leads tab of the ribbon,

in the Data group, click the
Import Data button.

2. In the Data File area, click the
Browse button to select a data file
for import.

3. Check to make sure that your
text delimiters are accurate.

4. Click the Next button.
5. Choose a data map. If this is your

first time importing this format
of file, you may need to create a
data map.

6. Follow the wizard steps until you
have finished your import. The
steps may vary depending on the
nature of your import job.

Outlook 2003/2007:
1. On the Leads menu, highlight

Import Data, then click the
Import Data button.

2. In the Data File area, click the
Browse button to select a data file
for import.

3. Check to make sure that your
text delimiters are accurate.

4. Click the Next button.
5. Choose a data map. If this is your

first time importing this format
of file, you may need to create a
data map.

6. Follow the wizard steps until you
have finished your import. The
steps may vary depending on the
nature of your import job.
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Task C Deleting a lead
If you no longer need a lead in the database, you can delete it. Deleting a lead
is different from disqualifying, closing, or converting a lead. When you delete a
lead, the lead and all related activities are removed from the database and is no
longer available for reporting purposes. Most of the time, you won’t want to
delete a lead; rather, you’ll disqualify it. If you accidentally enter a duplicate
lead, however, you’d want to permanently delete the duplicate.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Sales and then Leads.
2. Your current leads list should

appear.
3. Highlight the lead you’d like to

delete.
4. On the Leads tab of the ribbon,

in the Records group, click the
Delete button.

5. Confirm your deletion by
clicking OK.

Outlook 2003/2007:
1. In the Navigation Pane, click

Sales and then Leads.
2. Your current leads list should

appear.
3. Highlight the lead you’d like to

delete.
4. On the Leads menu, highlight

Delete, then click Delete.
5. Confirm your deletion by

clicking OK.

Deleted leads cannot be undeleted.
For this reason, most Microsoft
Dynamics CRM users will deactivate
records instead of deleting them.
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Viewing leads
If you’re a salesperson, your lead list is probably the most important thing in
Microsoft Dynamics CRM. It’s easy to find a specific lead in a one-off situa-
tion. If you find yourself looking for a set of leads often, you can create a view
to instantly bring up leads that match a specific query.

Task A Finding a lead
One of your prospects calls you, and you want to record information about the
lead in Microsoft Dynamics CRM. You can perform a quick search in the
Leads view to bring up any specific lead. When searching, all fields are
searched, so you can enter a name, company name, lead topic, or any other
information to bring up related leads.

Outlook 2010/Internet Explorer:
1. On the Navigation Pane, click

Sales and then Leads.
2. Your current leads list should

appear.
3. Enter a search term into the

Quick Find field above the list of
leads on the left and press Enter.

4. Microsoft Dynamics CRM will
search for your search term in all
lead fields.

5. The list of matching leads will
appear on the screen. To remove
the search filter, click the X
button to the right of the Search
field.

Outlook 2003/2007:
1. On the Navigation Pane, click

Sales and then Leads.
2. Your current leads list should

appear.
3. Enter a search term into the

Quick Find corner field above
the list of leads on the right and
press Enter.

4. Microsoft Dynamics CRM will
search for your search term in all
lead fields.

5. The list of matching leads will
appear on the screen. To remove
the search filter, click the X
button to the right of the Search
field.

If you don’t find the leads you’re
looking for, try using the alphabet bar
at the bottom of the view or running
an Advanced Find. In Outlook
2003/2007, Advanced Find is on the
toolbar. In Outlook 2010, Advanced
Find is on the Leads tab of the ribbon
in the Data group.
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Task B Switching between different lead
views

By default, the Leads view will show you all of your open leads. The view that
appears by default is called My Open Leads. If you want to look at a different
list of leads, you can just switch to a different Lead view. For example, instead
of showing all of your open leads, you might want to see all of the leads that
are older than six months. Just switch views, and you’ll see a whole different set
of records on the screen.

Internet Explorer/Outlook 2003:
1. On the Navigation Pane, click

Sales and then Leads.
2. Your current leads list should

appear.
3. Choose a view from the View

drop-down at the top of the leads
list.

4. All leads matching the query for
your view will appear.

Outlook 2007/2010:
1. On the Navigation Pane, click

Sales and then Leads.
2. Your current leads list should

appear.
3. At the top of the leads list, you

will see tabs representing the
views that have been pinned.
Click the furthest tab to the right
to add a new tab/view to your list
of existing tabs.

You can create personal or shared
views. Click the Advanced Find button
at the top of the screen. Configure the
details of your query, determine which
columns to display, and click the Save
As button to save the view.
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Qualifying leads
Leads are temporary, and all leads will be either qualified or disqualified at
some point. If someone purchases from your company, you’ll probably convert
the lead to an account or contact. If you lose the sale, you’ll disqualify the lead,
which will remove it from the list of active leads but still retain all communica-
tion history.

Task A Converting leads to accounts,
contacts, or opportunities

A lead is an unqualified prospect. It’s probable that you haven’t yet spoken with
the lead. Maybe it came in from a list you bought, or perhaps you got the
information from a trade show. Once you have determined that there is a
potential to sell something, you’ll want to qualify the lead. After converting a
lead to another record type, the original lead will be deactivated and set to
read-only and all relevant information will transfer to the new record.

Outlook 2010/Internet Explorer:
1. On the Navigation Pane, click

Sales and then Leads.
2. Your current leads list should

appear.
3. Highlight the lead you’d like to

convert.
4. On the Leads tab of the ribbon,

in the Actions group, click the
Qualify button.

5. Place a checkmark next to the
Account, Contact, and/or
Opportunity fields. If you choose
all three, Microsoft Dynamics
CRM will create an account, a
related contact, and a related
opportunity based on this lead
record.

6. Click OK.
7. The new entities will be created,

and the original lead record will
be deactivated.

Outlook 2003/2007:
1. On the Navigation Pane, click

Sales and then Leads.
2. Your current leads list should

appear.
3. Highlight the lead you’d like to

convert.
4. On the Leads menu, click the

Qualify button.
5. Choose Qualify and convert into

the following records option.
6. Place a checkmark next to the

Account, Contact, and/or
Opportunity fields. If you choose
all three, Microsoft Dynamics
CRM will create an account, a
related contact, and a related
opportunity based on this lead
record.

7. Click OK.
8. The new entities will be created,

and the original lead record will
be deactivated.

When converting the lead to an
opportunity, sometimes you’ll find
that someone has already created 
an account or contact record for the
lead. To avoid duplicates in this
situation, just convert the lead to 
an opportunity. When you do this,
you’ll be able to specify the potential
customer for the opportunity.
All activities captured while qualifying
the lead will be maintained within the
lead record. These activities can be
viewed from within the corresponding
account, contact, or lead by selecting
Activities from the Navigation Pane
and viewing “Related Regarding
Records.”
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Task B Disqualifying a lead
There’s no sense in chasing a dead lead, so Microsoft Dynamics CRM lets you
disqualify a lead. Disqualified leads will be removed from your active lead
views, but all lead information and activity history is retained in the system.
This way, if the customer ever calls again, you’ll know that you tried to do
business with him or her before.

Outlook 2010/Internet Explorer:
1. On the Navigation Pane, click

Sales and then Leads.
2. Your current leads list should

appear.
3. Highlight the lead you’d like to

convert.
4. On the Leads tab of the ribbon,

in the Actions group, click the
Qualify button.

5. Choose the Disqualify option.
6. From the Status drop-down,

choose a reason for disqualifying
the lead.

7. Click OK.

Outlook 2010/2007:
1. On the Navigation Pane, click

Sales and then Leads.
2. Your current leads list should

appear.
3. Highlight the lead you’d like to

convert.
4. On the Leads menu, click the

Qualify button.
5. Choose the Disqualify option.
6. From the Status drop-down,

choose a reason for disqualifying
the lead.

7. Click OK.

Reactivating a disqualified lead is
covered on the next page.



9

Maximizing Your Sales with Microsoft Dynamics CRM 2011

Task C Reactivating a closed lead
If you disqualify a lead, you can always reactive the lead. For example, perhaps
you determined the prospect did not have budget allocated for the project. 
A few weeks later, they call back and inform you that they have received 
executive sponsorship for the project. In this case, you’d reactivate the lead.

Outlook 2010/Internet Explorer:
1. On the Navigation Pane, click

Sales and then Leads.
2. Your current leads list should

appear.
3. From the View drop-down,

choose a view that will display
the lead you’d like to reactivate.
(For example, you could choose
the Closed Leads view.)

4. Highlight the lead.
5. On the Leads tab of the ribbon,

in the Records group, click the
Activate button.

6. You will now be able to work
with the lead, and it will show up
in your list of active leads.

Outlook 2003/2007:
1. On the Navigation Pane, click

Sales and then Leads.
2. Your current leads list should

appear.
3. From the View drop-down,

choose a view that will display
the lead you’d like to reactivate.
(For example, you could choose
the Closed Leads view.)

4. Highlight the lead.
5. On the Leads menu, click the

Activate button.
6. You will now be able to work

with the lead, and it will show up
in your list of active leads.

After reactivating a lead, check to
make sure all of your information is
up to date. If you were working on
this lead last year, the company may
have a new address or other contact
information.
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Creating and deleting records
Accounts are companies. In the hierarchy of customer records, accounts are
usually at the top. Within an account, you may have multiple associated
contacts. Microsoft is an account. Bill Gates is a contact.

Task A Creating a new record
Creating most new records in Microsoft Dynamics CRM follows the same
general process. In Outlook 2010/Internet Explorer, you’ll see a New button
on the ribbon in the Records group. In Outlook 2003/2007, the New button
is on the Record menu. You can follow the process below to create a new
record in Internet Explorer or Outlook 2003/2007.

Internet Explorer:
1. On the File tab, click New

Record, then select a record type.
2. Enter field data for your account.
3. On the ribbon in the Save group,

click the Save & Close button.

Outlook 2003/2007:
1. On the toolbar, click the New

Record drop-down and select a
record type.

2. Enter field data for your account.
3. Click the Save & Close button.

If you want to share your new record
with others, click on the record in your
list. On the ribbon in the Collaborate
group, click the Share button.
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Task B Editing an existing record
Anytime you see a list of records in Microsoft Dynamics CRM, you can
double-click the record. This brings up an edit window, where you can edit the
record. While you’re editing a record, notice the options on the left. You can
add additional addresses, activities, connections, and more.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click on a record type.
2. A record list should appear.
3. If necessary, use the Search field, alphabet bar, or the View drop-down to

locate the record you’d like to edit.
4. After finding the record you’d like to edit, double-click it in the list.

To go to a specific record, you could:
■ Run an Advanced Find.
■ Enter a term into the Quick Search.
■ Click a letter at the bottom of the

record list to jump to records that
begin with that letter.

You can only edit a record if your user
role allows editing of a particular type
of record. Your administrator also may
restrict your ability to edit records
that you do not own.
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Task C Deleting or deactivating a record
When a record is no longer needed, you have two basic options: You can delete
the record, or you can deactivate it. Deactivating a record removes it from your
list of active records, and removes it from most search results. Deactivating a
record does not, however, permanently remove the record from your database.

To view inactive records, go to the
record list and choose the Inactive
view from the View drop-down.
Deactivating a record is usually a
better idea than deleting it. When a
record is deleted, it is removed from
the database completely. You can
always reactivate a record that has
been deactivated.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click on

a record type.
2. A record list should appear.
3. Highlight the record you’d like to

deactivate.
4. On the ribbon in the Records

group, click the Delete or
Deactivate button.

5. Click OK to confirm the deacti-
vation or deletion.

Outlook 2003/2007:
1. In the Navigation Pane, click on

a record type.
2. A record list should appear.
3. Highlight the record you’d like to

deactivate.
4. On Record menu, click the

Deactivate button.
5. Click OK to confirm the 

deactivation.
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Task D Bulk deleting records
In addition to deleting records from the list views, you can also perform a bulk
deletion based on query. This will allow you to delete a group of records based
on particular criteria. System administrators should be extremely cautious
when granting users this privilege. It’s really easy to delete your entire data set
with this feature. And whoops! There’s no undo, and CRM Online users likely
won’t have a backup.

Users should be extremely cautious
when bulk deleting records. The
process of bulk deleting records can
be dangerous.
The system administrator should
consider disabling this function for
most users.

Outlook 2010/Internet Explorer:
1. On the ribbon in the Records

group, click the Delete drop-
down, then Bulk Delete.

2. Configure your search criteria.
3. Follow the wizard’s instructions

to complete the bulk deletion
job.

Outlook 2003/2007:
1. On the Record menu, highlight

Delete, then click Bulk Delete.
2. Configure your search criteria.
3. Follow the wizard’s instructions

to complete the bulk deletion
job.
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Task E Adding notes for a record
Most of your record data will be entered into fields, but sometimes you may
have important bits of information that don’t logically fit in a field. For these
situations, you can enter notes for a record.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click a record type.
2. Your current record list should appear.
3. Locate the record and double-click it in the list.
4. Click the Notes form section.
5. Click the option to add a new note and type the note.

You can add as many notes for a
record as you like. These instructions
for adding notes will work with most
other record types.
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Task F Adding attachments for a record
You have an important proposal. That proposal needs to be shared with the
other Microsoft Dynamics CRM users that have access to an account. You’d
like that proposal to be available every time you access the account record. Add
the proposal as an attachment to the account, and you’ll have all of this.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Sales and then Accounts.
2. Your current accounts list should appear.
3. Locate the account and double-click it in the list.
4. On the Create Related tab of the ribbon in the Include group, click the

Attach File button.
5. Browse and select the file.
6. Click the Attach button.
7. Click Close.

Attachments appear in the Notes
form section.
Be careful about adding large
attachments. They count toward your
total database size, and adding lots of
large attachments is a quick way to
outgrow your server or hosting plan.
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Viewing records
Once you’ve entered records into Microsoft Dynamics CRM, it will be helpful
to know how to find and display information for these records.

Task A Finding a record
Most of your searches will follow this quick lookup procedure. You need to call
someone at XYZ Company, and you need to bring up the account record to
get a main phone number. For this type of situation, use this procedure to find
a record.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click on a record type. (For example, you could

click on Contacts.)
2. Your current record list should appear.
3. Enter a search term into the Quick Search field and press Enter.
4. Microsoft Dynamics CRM will search for your search term in all record

fields.
5. The list of matching records will appear on the screen. To remove the

search filter, click the X button to the right of the Search field.

It’s easy to send a colleague a web
link to a record. Open any record. On
the ribbon, in the Collaborate group,
click either the Copy a Link or E-mail
a Link button. The shortcut link that is
copied or sent can be clicked by any
Microsoft Dynamics CRM user to go
directly to a specific account record.
If you don’t find the records you’re
looking for, try running an Advanced
Find.
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Task B Switching views
When you go to the record list, the records that appear are defined by the
current view. By default, you will see your active accounts, but you can switch
views to see deactivated accounts, all active accounts, accounts that have not
ordered anything in the last six months, and so on.

You can create your own views in the
Advanced Find area. Run an Advanced
Find, create a query, and save the
query as a view.
When you create your own views, you
can also define the columns that
appear when the view is invoked.

Internet Explorer/Outlook 2003:
1. In the Navigation Pane, click on

a record type.
2. A record list should appear.
3. In the upper-left corner of the

record list, choose a view from
the View drop-down.

4. All matching accounts that
match the view’s query will
appear.

Outlook 2007/2010:
1. Go to a list of records. For

example, you might go to your
list of Accounts.

2. The tabs at the top of the list
show the views that have been
pinned. To add a new view/tab to
the list of tabs, click the furthest
tab to the right and select a view
from the list that appears.
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Task C Viewing pending and closed activities
for a record

When you complete activities with a record, Microsoft Dynamics CRM creates
a history of the activity having been completed. For example, if you write a
letter, send an e-mail, or complete an appointment, an activity history is
created. If you’re looking for a chronological list of everything that has
happened with a record, check the Closed Activities area.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click on a record type. For example, you might

click on Leads.
2. A record list should appear.
3. Locate the record and double-click it in the list.
4. On the left, click the Activities option to see pending activities. Click the

Closed Activities option to see a list of completed activities.

Click the Export Activities button on
the ribbon in the Data group to export
all of the activities data on the screen
to an Excel spreadsheet.
At the top of the activities list, make
sure your filter is set properly. By
default, you will only see history
entries for the last 30 days.
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Task D Printing information about a record
Having information about a record in Microsoft Dynamics CRM is useful, but
you may sometimes want the ability to print that information and take it to an
appointment. For most records, you can click the Print Preview button on the
File tab to print a quick report of relevant information for that record.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click on a record type. For example, you might

click on Cases.
2. A record list should appear.
3. Double-click a record.
4. On the File tab, click the Print Preview button. This will generate a print-

able list of all account data, including notes.

If you need a specific format for your
account information, consider running
a report or exporting the data to
Excel.
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Task E Viewing contacts associated with 
an account

You can associate contacts with an account. After bringing up an account for
editing, the buttons on the left of the account screen will show all of the associ-
ated records.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Sales and then Accounts.
2. Your current accounts list should appear.
3. Double-click an account.
4. On the left, click the Contacts option to see associated contacts.
5. A list of all related contacts will appear.

To create a new contact under this
account, click the Add New Contact
button on the ribbon in the Records
group.
To associate another existing contact
with this account, click the Add
Existing Contact button on the ribbon
in the Records group.
If you have created custom entities,
you may be able to associate those
entities with an account as well.
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Task F Setting conditional formatting on 
a view

The conditional formatting feature allows you to set the font type, size, and
color for a record based on a query that you configure. So, in your list of
opportunities, you might want high-priority opportunities to show in red. This
conditional format makes it easier to spot the opportunities that require your
first attention. This feature is only available to CRM users in Outlook 2010.

Outlook 2010:
1. In the Navigation Pane in Outlook 2010, click on a record type. For

example, you might click on Contacts.
2. On the View tab, in the Current View group of the ribbon, click the View

Settings button.
3. Click the Conditional Formatting button.
4. Click Add to create a new rule, and click the Font button to specify the

font formatting for that rule.
5. Click OK to confirm the new conditional formatting rule.

This feature is only available to users
with Outlook 2010, so if you’re on an
old version of Outlook, now might be
a good time to upgrade. 2003 was
quite a while ago….
Conditional formatting is also
available on your list of local Outlook
contacts.
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Sharing records
If you are using Microsoft Dynamics CRM in a multi-user environment, you
may set up the system so that everyone sees everything. You can also configure
the database to only allow specific levels of access to individual users or teams.

Task A Assigning a record to another user
or team

If you enter a record into Microsoft Dynamics CRM, you own that record by
default. After double-clicking a record, you can click the Administration form
section (on the left) to see the current owner for any record. You can easily
transfer ownership, provided that you have sufficient rights within the system.

You can also change ownership by
clicking the Lookup button on the
Owner field.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click on

a record type.
2. A record list should appear.
3. Highlight a record.
4. On the ribbon in the Collaborate

group, click the Assign button.
5. Choose the Assign to another

user or team option.
6. Click the Search button and

choose a user.
7. Click OK.

Outlook 2003/2007:
1. In the Navigation Pane, click on

a record type.
2. A record list should appear.
3. Highlight a record.
4. On the Record menu click the

Assign button.
5. Choose the Assign to another

user or team option.
6. Click the Search button and

choose a user.
7. Click OK.
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Task B Sharing a record with another user
or team

If your database is configured so that each user only has access to specific
records, you may find the need to share a record with another user. Following
this procedure will share access with another user, but you can also share access
with a team of users.

If you grant access to a team, all users
assigned to that team will get access
to the record.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click on

a record type.
2. A record list should appear.
3. Highlight a record.
4. On the ribbon, in the

Collaborate group, click the
Share button.

5. Click the Add User/Team option
to add new users or teams to the
access list.

6. Click OK.

Outlook 2003/2007:
1. In the Navigation Pane, click on

a record type.
2. A record list should appear.
3. Highlight a record.
4. On the Record menu click the

Share button.
5. Click the Add User/Team option

to add new users or teams to the
access list.

6. Click OK.
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Task C Checking your permissions for a
record

On each record, you may have specific permissions granted. For example, even
though you may have access to modify accounts, the record owner of a specific
account might have restricted your ability to edit that record. At any point, you
can check your permissions for a record, and then you’ll know exactly what
you can do with the record.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click on a record type.
2. A record list should appear.
3. Locate the record and double-click it in the list.
4. On the File tab, click on the Properties button.
5. A list of permissions for the record will appear. A checkmark will appear

next to any permission you have for the current record.

Available permissions are:
■ Read
■ Write
■ Append
■ Append To
■ Share
■ Assign
■ Delete
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Creating connections between records
Connections allow you to track relationships between records in your database.
If you are about to call a customer, you can check the connections area within
CRM to see if any other people within your organization have some kind of
connection to this customer. You’ll also see connections that your customer has
with other contacts, accounts, opportunities, or other records. Basically, the
connections feature allows you to relate any record to another record within
CRM.

Task A Defining a connection between two
records

John Smith is a contact in your database. Jane Doe is also a contact in your
database. Jane is John’s ex-wife. You’re about to meet with John, and you look
in the connections area to see what kind of connections John has defined. In
the connections area, you see that John and Jane were married, and you now
know that bringing up the big project you just finished for Jane might not be
your best selling strategy.

The Connections entity in Microsoft
Dynamics CRM 2011 is customizable.
You can, for example, add a field or
form to this entity.
Microsoft Dynamics CRM comes with
a number of default connection roles.
If these default roles do not work for
you, then you can create a custom
connection role.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click on

a record type.
2. A record list should appear.
3. Locate the contact and double-

click it.
4. On the ribbon in the Records

group, click the Connect drop-
down, then To Another.

5. Click the Search button next to
the Name field.

6. Find your record.
7. Give the new connection a

connection role.
8. On the ribbon in the Save group,

click Save & Close.

Outlook 2003/2007:
1. In the Navigation Pane, click

Sales and then Contacts.
2. Your current contacts list should

appear.
3. Locate the contact and double-

click it.
4. Click the Search button next to

the Parent Customer field to
bring up a list of accounts.

5. Highlight an account record and
click OK.

6. The contact is now linked with
an account.
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Task B Connecting a record to yourself
Let’s say you work for XYZ Company. You used to work for ABC Company,
an important account in your current organization’s database. By connecting
yourself to your old organization, you can clue your current company in on
your special relationship to this account.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click on a record type.
2. A record list should appear.
3. Locate the contact and double-click it.
4. On the ribbon in the Records group, click the Connect drop-down, then

To Me.
5. Select a connection role.
6. On the ribbon in the Save group, click Save & Close.

Connecting users to records in your
database can be useful for many
organizations. This feature basically
allows you to keep a record of who
knows whom in your database.
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Task C Defining connection roles
Before you establish connections between records in your database, you need to
define the various connection roles that your organization wants to apply.
These roles are then applied when you establish connections between different
records in your database.

Outlook 2010/Internet Explorer:
1. On the Navigation Pane, click Settings, then Business Management.
2. Click Connection Roles.
3. Click the New button.
4. Specify a name and any other important information about your connec-

tion role.
5. Click the Save and Close button.

You can define relationship roles for
most of the record types in your
database, not just Accounts, Contacts,
and Opportunities.
The system administrator should set
up and define connection roles for the
organization.
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Finding records
You can have a million records in your database, but it won’t do you any good
if you can’t find them. Using the Quick Find and Advanced Find features in
Microsoft Dynamics CRM, you can easily find a single record, and you can
create a sub-set of your database for inclusion in a marketing list, campaign,
quick campaign, export, or more.

Task A Searching with a Quick Find
When you are looking at a list of records—like a list of contacts or accounts—
you can easily search for specific records within the list using the search field.
The search field appears at the top of every record list.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click the type of record you’d like to find. For

example, you could click Sales and then Contacts to bring up a list of
contacts.

2. Once the list of records appears, you should see a search field at the top of
the list. You may see the text “Search for records” in the field.

3. In this field, type a search term. For example, if you are looking for the
Betty Smith contact record, you could type Smith into the field. 
(Use an * asterisk as a wild card in your searches.)

4. Click the magnifying glass icon to the right of the field to execute the
search.

The fields that are searched in a Quick
Find can be customized. For the
account record, for example, the
default fields that are searched are
Account Name, Account Number, and
E-mail. For contacts, Full Name, First,
Middle, Last, E-mail, and Case
Number are searched.
After running a search, your view
automatically changes to display the
Search Results view. Click the View
drop-down to go back to looking at a
different set of records.
This search procedure works for all
CRM entity lists, including contacts,
accounts, leads, opportunities, custom
entities, etc.
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Task B Changing the fields that are searched
when performing a Quick Find

When you run a default Quick Find in CRM, only a few major fields are
searched. If you want your Quick Find searches to yield more accurate results,
then you can change the fields that are searched whenever you perform a
Quick Find. If you have a customer number in CRM, and that customer
number is a custom field that isn’t searched with the Quick Find, adding it to
the list of fields that is searched may make it easier to find records.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click on

a record type.
2. A record list should appear.
3. On the Customize tab of the

ribbon in the Customize group,
click the System Views button.

4. Double-click the Quick Find
View.

5. On the right, click the Add Find
Columns button.

6. Check any fields that you want
to search and click OK.

7. Click the Save & Close button.

Outlook 2003/2007:
1. In the Navigation Pane, click on

a record type.
2. A record list should appear.
3. On the Customize menu, click

the System Views button.
4. Double-click the Quick Find

View.
5. On the right, click the Add Find

Columns button.
6. Check any fields that you want

to search and click OK.
7. Click the Save & Close button.

Always remember to publish your
customizations. If you do not publish
your customizations, the changes
you’ve made will not appear in the
live system.
This is likely an administrator
function, so if you are not an
administrator in your CRM system,
you should ask your administrator to
perform these steps.
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Task C Filtering a view
Filters in CRM are just like filtered columns in Excel. When you turn on filters
for a list view, you can reduce the number of records that appear. For example,
you might want to filter a list to only show records in the United States. Each
column in a view can be filtered to show certain records based on your custom
filter.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click on

a record type.
2. A record list should appear.
3. Click the Filter drop-down above

the record list, then highlight
Add Filter.

4. Select a column.
5. Configure your custom filter and

click OK.

Outlook 2003/2007:
1. On the View menu, click the

Filter button.
2. On the column header, click the

Filter drop-down, then the
Custom Filter button.

3. Configure your custom filter and
click OK.

You can save filters as a new view.
You can also apply a filter to each
column in a view. Just click the Filter
button and choose the option to save
as a new personal view. (Outlook
2010 only.)
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Task D Pinning a view in Outlook 2007/2010
When viewing your CRM data within Outlook 2007/2010, views of records
are shown as tabs at the top of the record list. If you use a particular view
frequently, you can pin the view, and it will appear at the top of the list until
you remove the pin. This feature is not available for Internet Explorer or
Outlook 2003 users.

Outlook 2007/2010:
1. Go to a list of CRM records in Outlook. For example, you might go to

your list of leads.
2. At the top of the list of records, click the tab that is furthest to the right.

This will bring up a list of views.
3. Select a view, and that view will display as a tab.
4. Click the pushpin icon to the left of the view name to pin the view.

Pinning a view only pins it for you.
Other users will be able to pin their
own views.
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Task E Grouping a list by a field
When you are looking at your Inbox in Outlook, you might group your
incoming e-mails by date, sender, or priority. The same grouping feature avail-
able in your Inbox is also available on most CRM record lists in Outlook 2007
and Outlook 2010. Just group by a field, and all data shown in your view will
be grouped by the values in the field.

Outlook 2007/2010:
1. In the Navigation Pane, click on a record type. For example, you might

click on Opportunities.
2. At the top of your list view, right-click on the column that you’d like to

group.
3. Choose the Group by this field option.
4. Your records will now be grouped by that field.

In your Opportunities list view, right-
click the Priority field and choose to
group by the field to see all of your
high-, medium-, and low-priority
opportunities grouped together.
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Advanced Find
The Advanced Find feature lets you use Boolean operators to find a very
specific set of data. If you run an Advanced Find often, you can save it as a
view. All of the instructions in this section apply to all entities, including
contacts, accounts, leads, opportunities, and more.

Task A Using the Advanced Find feature
On the ribbon in Microsoft Dynamics CRM (or on the toolbar, if you are
using Outlook 2003/2007), you’ll see an Advanced Find button. When
performing an Advanced Find, you can search any entity, and you can search
multiple fields at once.

Outlook 2010/Internet Explorer:
1. In the Data group of the ribbon,

click the Advanced Find button.
2. In the Look for drop-down,

select the entity type you’d like 
to find. (Contacts, leads, activi-
ties, etc.)

3. Hover your mouse over the
underlined Select word in the
details area. A field drop-down
will appear. Select a field from
the drop-down.

4. To the right of the field you
selected, an operator will appear.
Choose your operator.

5. Click the Enter Value link and
type the field value you’d like to
find.

6. Repeat this process as many
times as necessary. (Each value
entered connects with an implied
“and,” but you can change the
operator between lines to “or”
before running the Advanced
Find.)

Outlook 2003/2007:
1. On the toolbar, click the

Advanced Find button.
2. In the Look for drop-down,

select the entity type you’d like 
to find. (Contacts, leads, activi-
ties, etc.)

3. Hover your mouse over the
underlined Select word in the
details area. A field drop-down
will appear. Select a field from
the drop-down.

4. To the right of the field you
selected, an operator will appear.
Choose your operator.

5. Click the Enter Value link and
type the field value you’d like to
find.

6. Repeat this process as many
times as necessary. (Each value
entered connects with an implied
“and,” but you can change the
operator between lines to “or”
before running the Advanced
Find.)

After clicking the Advanced Find
button, click the Saved Views tab to
see a list of views (Advanced Find
search results) that you have
previously saved.
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Task B Exporting an Advanced Find view
to Excel

Anytime you run an Advanced Find, the results of the Advanced Find can be
easily exported to an Excel spreadsheet. Let’s say one of your outsourced
marketing vendors needs a list of your active accounts in Texas for a mailer.
Run an Advanced Find on the contact entity that searches for State = TX, and
you’re only one click away from the exported data.

Outlook 2010/Internet Explorer:
1. In the Data group of the ribbon,

click the Advanced Find button.
2. Configure your Advanced Find

query. For help with this, see
Task A in this section.

3. In the Show group of the ribbon,
click the Results button.

4. The results of the query will
appear in the Advanced Find
screen.

5. In the Date group of the ribbon,
click the Export Leads button.

6. Select the type of worksheet to
export.

7. Click Export.

Outlook 2003/2007:
1. On the toolbar, click the

Advanced Find button.
2. Configure your Advanced Find

query. For help with this, see
Task A in this section.

3. In the Show group of the ribbon,
click the Results button.

4. The results of the query will
appear in the Advanced Find
screen.

5. In the Date group of the ribbon,
click the Export Leads button.

6. Select the type of worksheet to
export.

7. Click Export.

After running an Advanced Find, click
the checkmark field under the New
button to highlight all records. Then:
■ Click the Create Quick Campaign

button to create a quick campaign
for all selected records.

■ Click the Mail Merge button to
begin the Mail Merge Wizard for all
contacts.

■ Click the Add to Marketing List
button to save the Advanced Find
results into a marketing list.
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Task C Changing the columns that show in
Advanced Find search results

The Advanced Find view determines the default set of columns (fields) that
appear when you view Advanced Find search results. With a few quick clicks,
though, you can add or remove fields from your Advanced Find results. If you
spend a lot of time configuring columns, you can save the Advanced Find as a
personal view.

Outlook 2010/Internet Explorer:
1. Go to a list of CRM records. For

example, you could go to the
Accounts view.

2. In the Data group of the ribbon,
click the Advanced Find button.

3. Configure your Advanced Find.
4. In the View group of the Ribbon,

click the Edit Columns button.
5. Click the Add Columns button

to add columns to the search
results.

Outlook 2003/2007:
1. On the toolbar, click the

Advanced Find button.
2. Configure your Advanced Find.
3. In the View group of the Ribbon,

click the Edit Columns button.
4. Click the Add Columns button

to add columns to your search
results.
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Personal views
The Advanced Find feature lets you use Boolean operators to find a very
specific set of data. If you run an Advanced Find often, you can save it as a
view. All of the instructions in this section apply to all entities, including
contacts, accounts, leads, opportunities, and more.

Task A Creating a personal view
If you find yourself searching for the same set of records consistently, you will
save a lot of time by saving the Advanced Find. You can save the Advanced
Find query that defines which records will show in the view, and you can
specify the columns of data that will appear in the view.

Outlook 2010/Internet Explorer:
1. In the Data group of the ribbon,

click the Advanced Find button.
2. In the Look for drop-down,

select the entity type you’d like to
find. (Contacts, leads, activities,
etc.)

3. Configure your query.
Instructions for completing a
query can be found on the
previous page.

4. Click the Edit Columns button
to specify the columns of data
that will appear in the view.

5. In the View group of the ribbon,
click the Save button.

6. Give your new view a name.

Outlook 2003/2007:
1. On the toolbar, click the

Advanced Find button.
2. In the Look for drop-down,

select the entity type you’d like to
find. (Contacts, leads, activities,
etc.)

3. Configure your query.
Instructions for completing a
query can be found on the
previous page.

4. Click the Edit Columns button
to specify the columns of data
that will appear in the view.

5. In the View group of the ribbon,
click the Save button.

6. Give your new view a name.

To edit an existing view, go to that
view in your records list. Then, click
the Advanced Find button. Any
changes made to the Advanced Find
will be applied to the current view
when you click the Save button on
ribbon.
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Task B Setting your default personal view
Whenever you click an entity in the Navigation Pane, CRM will automatically
open the default view. If you would like a different view to open whenever you
click an entity, then you can change your default personal view. In Outlook
2007 and 2010, you can pin a view to make it automatically appear. (Pinning
is covered earlier in this chapter.) Outlook 2003 users cannot set a default
personal view.

Internet Explorer:
1. In the Navigation Pane, click on a record type.
2. A record list should appear.
3. From the View drop-down, change your view.
4. On the View tab in the List group of the ribbon, click the Set as Default

View button.

This method only sets your own
default personal view. Resetting your
own default view will not affect other
users in CRM.
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Searching for duplicates
Duplicates are an undesired part of any database. Within your list of contacts
and accounts, duplicates can be especially menacing. If a customer exists in
your database twice, it might mean that two different people from your organi-
zation are dealing with the customer. It might also mean that the customer is
contacted twice each time you send out mass correspondence.

Task A Finding duplicates
You can create a duplicate detection job that will find similar lead, account,
and contact records. Once you’ve identified the duplicates, you’re only a couple
of clicks away from merging them. Without running a duplicate detection job,
you can highlight any duplicate customers in a list view. You’ll see a Merge
button on the ribbon in Outlook 2010/Internet Explorer and on the Actions
menu in Outlook 2003/2007 that will let you manually merge the duplicates
that you’ve identified in the view.

Outlook 2010/Internet Explorer:
1. Go to a list of records. For

example, you could go to a list of
contacts.

2. In the Records group of the
ribbon, click the Detect
Duplicates button. You will have
the option to detect duplicates
for either the selected records or
all records on all pages.

3. Give your duplicate detection job
a name, start time, and
frequency.

4. Check the option to send an e-
mail when the job is completed.

5. Click OK.

Outlook 2003/2007:
1. Go to a list of records. For

example, you could go to a list of
contacts.

2. On the Record menu, highlight
Detect Duplicates. You will have
the option to detect duplicates
for either the selected records or
all records on all pages.

3. Give your duplicate detection job
a name, start time, and
frequency.

4. Check the option to send an e-
mail when the job is completed.

5. Click OK.

Only specify a frequency (in step 3)
for the duplicate detection if you want
the program to re-run this duplicate
detection job on a scheduled basis.
Go to the next page for instructions
on how to see the results of a
duplicate record search.
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Task B Viewing duplicate records
Once the duplicate detection job has completed, the results are viewable in the
My Work section of the Workplace. For small databases, it usually only takes a
few minutes to complete a duplicate detection job.

Outlook 2003/2007/2010/Internet Explorer:
1. On the Navigation Pane, click Workplace.
2. In the My Work section, click Duplicate Detection.
3. All of your duplicate detection jobs will appear.
4. Double-click the duplicate detection job you’d like to view.
5. On the left, click the View Duplicates option.

Duplicate detection jobs usually finish
fairly quickly, but you can always
check the option to send a reminder
e-mail when the job has completed.
This way, you won’t waste any time
waiting for the job to complete.



Chapter 3 Searches and Views

44

Task C Merging duplicate records
Once duplicates have been identified, you can merge them automatically. You
can also merge them with a preview. Merging with a preview gives you the
ability to keep specific fields from either the master or subordinate record.
Once the records are merged, the subordinate record is deactivated.

Outlook 2010/Internet Explorer:
1. Go to an account, contact, or

lead list.
2. Click the first duplicate record,

hold the Ctrl key, and click
another duplicate. This high-
lights the two duplicate records.

3. In the Records group of the
ribbon, click the Merge button.

Outlook 2003/2007:
1. Go to an account, contact, or

lead list.
2. Click the first duplicate record,

hold the Ctrl key, and click
another duplicate. This high-
lights the two duplicate records.

3. On the Record menu, click the
Merge button.

When you merge two records, the
subordinate record is deactivated.
If you ever need to get data back 
from the record, you can always 
re-activate it.
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Creating a dashboard
Dashboards allow you to read and analyze your CRM data quickly and visu-
ally. Dashboards can be created and customized to display a wide range of
components, including graphs, sales pipelines, and iFrames.

Task A Creating a system dashboard
You can create a system dashboard in the same manner that you would create a
system view. Additionally, like a system view, a system dashboard is readable to
all users in the CRM system. Once you’ve created a system dashboard, you can
open it by clicking the dashboard drop-down and selecting it from the list of
options.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings, Customize, and then Customize the

System.
2. On the left, select the Dashboards option.
3. On the Actions toolbar, click the New button.
4. Configure your dashboard.
5. Click the Save and Close button when you are done.

Dashboards in CRM aren’t only
limited to showing charts and lists of
data in your system. You can also
insert web resources and iFrames if
you want to display a document or a
live web page.
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Task B Creating a personal dashboard
In addition to creating a system dashboard, you can also create a personal dash-
board. A personal dashboard belongs to the user who created it. Other CRM
users can’t use your personal dashboards, but you have the option to create a
personal dashboard and then share it with a user or team. Sharing dashboards
is covered in Task D.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Workplace, My Work, then
Dashboards.

2. On the Dashboards tab in the
Dashboard Management group
of the ribbon, click the New
button.

3. Configure your dashboard.
4. Click the Save and Close button

when you are done.

Outlook 2003/2007:
1. In the Navigation Pane, click

Workplace, My Work, then
Dashboards.

2. On the Dashboards menu, click
the New button.

3. Configure your dashboard.
4. Click the Save and Close button

when you are done.

You can set a personal dashboard as
your default dashboard by clicking the
Set As Default button in the ribbon in
Internet Explorer/Outlook 2010 and in
the Dashboards menu in Outlook
2003/2007.
You can share a dashboard with other
users or teams. You can also re-assign
a dashboard. Sharing and re-assigning
dashboards is covered later in this
chapter.
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Task C Editing a dashboard
You can also edit the items that appear in a dashboard after it has been created.
Items like charts and lists can be moved, replaced, and removed from the dash-
board. Additionally, you can change the layout of the dashboard by resizing the
dashboard sections.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Workplace, My Work, then
Dashboards.

2. On the Dashboards tab in the
Dashboard Management group
of the ribbon, click the New
button.

3. Select a dashboard layout and
click the Edit button.

4. Reconfigure the layout of your
dashboard.

5. On the ribbon in the Save group,
click the Save & Close button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Workplace, My Work, then
Dashboards.

2. On the Dashboards menu, click
the New button.

3. Select a dashboard layout and
click the Edit button.

4. Reconfigure the layout of your
dashboard.

5. On the ribbon in the Save group,
click the Save & Close button.

To edit the individual components in
your dashboard, select the component
and click the Edit Component button
on the ribbon. From here, you can
modify the properties of this
component.
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Task D Sharing a personal dashboard with
other users or teams

At some point, another CRM user might want to use one of your personal
dashboards. You can share your personal dashboards with other users or teams,
much in the same manner that you can share a personal view.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Workplace, My Work, then
Dashboards.

2. On the Dashboards tab in the
Action group of the ribbon, click
the Share this Dashboard button.

3. On the left, click the Add
User/Team button to add a user
or team.

4. When you are finished sharing,
click the OK button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Workplace, My Work, then
Dashboards.

2. On the Dashboards menu, click
the Share this Dashboard button.

3. On the left, click the Add
User/Team button to add a user
or team.

4. When you are finished sharing,
click the OK button.

You can also specify what other users
are allowed to do with your personal
dashboard. If, for example, you don’t
want other users to be able to edit
your dashboard, then you can take
away their Write privilege.
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Task E Creating dashboard charts and views
At some point, you might want to add a custom chart to one of your dash-
boards. You might, for instance, want a chart to display your accounts by cate-
gory. Charts are created for specific entities, so if you want to create two similar
charts for contacts and accounts, then you would need to create a chart for
each entity.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Customization, and then Customize the

System.
2. On the left, click the Entities option and then select an entity, such as

Account.
3. On the left, click the Charts option.
4. On the Actions toolbar, click the New button.
5. Configure your chart and click the Save & Close button when you 

are done.

The directions in Task E outline the
steps for creating a system chart. You
can also create a personal chart. To
create a personal chart, click on an
entity in the Navigation Pane, and
then click the New Chart button on
the Charts tab in Internet
Explorer/Outlook 2010 and on the
Charts menu in Outlook 2003/2007.
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Using dashboards
Dashboards are really useful because they allow you to visually see summaries
of your data without having to go through the traditional process of creating
extensive reports.

Task A Viewing, switching, and enlarging
dashboards

Users aren’t limited to a single dashboard. Rather, they can move between
different dashboards in the same way that they can move between views. To
switch to a different dashboard, follow the directions below.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Workplace, My Work, then Dashboards.
2. The default dashboard should appear.
3. Above the dashboard, click the Dashboard drop-down.
4. Select a dashboard from the drop-down.

You can click the Refresh Chart button
in the top-right corner of a dashboard
component to display the most up-to-
date data.
You can also enlarge a chart by
clicking the Enlarge the Chart button
in the top-left corner of a dashboard
component.
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Task B Drilling down data
By drilling down data, you can further analyze the data within a particular data
item. You might, for example, want to drill down into the estimated revenue
data in a sales pipeline. Drilling down data is as simple as clicking on a data
unit in a chart and specifying a new chart.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Workplace, My Work, then Dashboards.
2. The default dashboard should appear.
3. On a chart, click on a data item.
4. Configure the chart for your drilled down data.
5. Click the OK button.

To go back to your original chart, click
the home icon in the bottom-left
corner of the dashboard component.
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Task C Viewing source records on a chart
Dashboard charts are visual representations of your CRM data. If you would
rather view this data in list form, then you can view the source records on a
chart. The records will then appear as they do elsewhere in CRM.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click Workplace, My Work, then Dashboards.
2. The default dashboard should appear.
3. In the top-right corner of a chart, click the View Source Records icon.
4. A list will appear showing all of the source data that make up the chart.

The chart displaying the source data
appears next to the list of records. If
you drill down data on this chart, the
list will then refresh showing the
source records for the drilled down
data.
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Installing the Outlook plugin
If you run CRM in Internet Explorer, then you don’t need to install any files
on your computer. If you want to run CRM in Outlook, however, you will
need to install the Outlook plugin.

Task A Installing the plugin
Installing the CRM for Outlook plugin follows a pretty straightforward
process. Simply run the install file and follow the steps. You can download the
installation file in the Resource Center within CRM, or ask your administrator.

Installing the plugin:
1. Locate the CRM for Outlook plugin install file and double-click it.
2. Follow the steps to install the plugin.
3. Eventually you will be prompted to configure CRM for Outlook. This is

where you will type in your server URL and authentication info.

You will need to install the .NET
framework 3.5 service pack 1 or later
to install the CRM plugin. If it’s not
already on your computer, the system
will prompt you to install .NET.
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Outlook/CRM synchronization
Regardless of whether you are using CRM online or on-premise, you have the
option to work with CRM data within Outlook while you are offline. If you
are unsure about whether this feature is configured, check with your adminis-
trator. Offline data is only available if you chose to make data available offline
during the plugin installation.

Task A Going offline and online
When you are online, Microsoft Dynamics CRM displays live data from your
server. In the background, though, a separate copy of the data is kept in a
Microsoft SQL Express database on your local computer. When you go offline,
Outlook displays data from your local copy of the database. Once you go back
online, Microsoft Dynamics CRM will synchronize your local copy with the
data on the server.

Outlook 2010:
1. Click the File tab, select the

CRM option, and then click the
Go Offline button.

2. You can tell that you are offline
when the button you just clicked
changes to Go Online.

Outlook 2003/2007:
1. To manually go offline, click the

Go Offline button on the CRM
toolbar in Outlook.

2. You can tell that you are offline
when the button on the toolbar
reads Go Online.

When you go offline, Microsoft
Dynamics CRM will automatically
synchronize and prepare your offline
database for offline use.
Hover the mouse over the Dynamics
icon in the system tray (in the bottom-
right corner of the taskbar) to see if
Microsoft Dynamics CRM is online.
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Task B Configuring which records sync from
CRM to Outlook

If you have a large number of records, it’s unlikely that you’ll want access to
your entire company’s database on your phone. In the synchronization options,
you can configure Outlook filters. Only records that are included in your
Outlook filters will sync from CRM to Outlook. So, for example, if your
Outlook filter was set to bring all contacts in Texas down to Outlook, then any
contact in Texas from the CRM database would show up in your local Outlook
contacts list.

Outlook 2010/Internet Explorer:
1. In Outlook, on the File tab,

select the CRM option, then
click the Synchronization drop-
down. Then select the Outlook
Filters option.

2. A list of filters will appear.
3. Double-click the My Outlook

Contacts filter to edit the query
that sends contacts from CRM
into Outlook.

Outlook 2003/2007:
1. In Outlook, Click CRM |

Outlook Filters. (After installing
Microsoft Dynamics CRM, you
should get a CRM menu on the
Outlook menu bar.)

2. A list of local data groups will
appear.

3. Double-click the My Outlook
Contacts filter to edit the query
that sends contacts from CRM
into Outlook.

Configuring filters is a great way to
get your Microsoft Dynamics CRM
data into your handheld devices. Let’s
say that you want to make sure you
have contacts in New York (assuming
you do not own all the records)
available in your phone. Configure a
filter to sync everyone in New York
with Outlook, and (assuming your
phone is set to synchronize with
Outlook) all New Yorkers will
automatically show up on the phone.
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Working with CRM contacts, accounts,
and leads in Outlook
In the Navigation Pane, click Mail and then Microsoft Dynamics CRM. In
this area, you will have access to every function available in the CRM web
client. Beyond this integration, though, many of the native Outlook features—
like appointments and contacts—will synchronize seamlessly with your
Microsoft Dynamics CRM data.

Task A Tracking existing Outlook contacts
in CRM

Especially if you are first starting out with Microsoft Dynamics CRM, chances
are good that you have a few contacts in Outlook. With the Microsoft
Dynamics CRM Outlook client installed, you can continue to use these
contacts. With a single click, you can promote one (or many of them) to
Microsoft Dynamics CRM. From that point forward, the contact in your local
Outlook contacts list will appear in CRM, and changes made in either CRM
or Outlook will sync.

Outlook 2003/2007/2010:
1. Go to your list of contacts in Outlook. Note that this is not your list of

contacts in Microsoft Dynamics CRM. The easiest way to get to your list of
Outlook contacts is to click Contacts on the Navigation Pane on the left.

2. Double-click an Outlook contact to edit it.
3. At the top of the Contact form, click the Track button.
4. Click the Set Parent button to specify the parent account (company) in

CRM for this contact.
5. Click the Save and Close button. This contact will now be bi-directionally

synchronized between Outlook and Microsoft Dynamics CRM.
6. To see only your CRM contacts within Outlook, choose the CRM option

on the menu. Select Go To | Sales | Contacts. This will bring up a list of
only the CRM contacts and Outlook contacts that are tracked in CRM.
Regular Outlook contacts not tracked in CRM will not show in this list.

When you’re looking at the list of
Outlook contacts, you’ll see a CRM
icon next to the contacts that are set
to automatically sync with Outlook.
In the contacts list in Outlook, you
can highlight single (or as many as 20
at a time) records and click the Track
button to track multiple Outlook
records back in Microsoft Dynamics
CRM.
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Task B Working with CRM accounts within
Outlook

Without Microsoft Dynamics CRM installed, Outlook doesn’t have a feature
to store account data. Because all of your Microsoft Dynamics CRM data is
available in Outlook, though, you can easily create CRM accounts from within
the Outlook interface.

Outlook 2010:
1. From the CRM Record drop-

down on the CRM tab of the
ribbon, choose the Account
option.

2. The New Account dialog box
will appear. Enter field informa-
tion for your new account.

3. Click the Save and Close button.

Outlook 2003/2007:
1. From the New Record drop-

down on the CRM toolbar,
choose the Account option.

2. The New Account dialog box
will appear. Enter field informa-
tion for your new account.

3. Click the Save and Close button.

From the New Record drop-down, you
can create any type of CRM record,
including custom entities. Need to
create a new support case? From the
New Record drop-down, choose the
Case option.
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Task C Working with CRM leads in Outlook
In Chapter 1, we covered the process of adding new leads to Microsoft
Dynamics CRM. We included this task to illustrate how you can perform the
same actions from within the Outlook interface. After completing this task,
take a moment to read through Chapter 1. All of the tasks in that chapter can
be done within Outlook as well. Outlook e-mails can be tracked in CRM and
then converted to leads from the CRM e-mail activity.

Outlook 2010/Internet Explorer:
1. From the CRM Record drop-

down on the CRM tab, choose
the Lead option.

2. The New Lead dialog box will
appear. Enter field information
for your new lead.

3. Click the Save and Close button.
4. To see your leads within

Outlook, choose the CRM
option on the menu. Select Go
To | Sales | Leads.

Outlook 2003/2007:
1. From the New Record drop-

down on the CRM toolbar,
choose the Lead option.

2. The New Lead dialog box will
appear. Enter field information
for your new lead.

3. Click the Save and Close button.
4. To see your leads within

Outlook, choose the CRM
option on the menu. Select Go
To | Sales | Leads.

Before you can add the new lead to a
marketing list or campaign, you’ll
need to save it. Just click the Save
button at the top of the New Lead
screen to enable the Marketing List or
Campaign options on the left.
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Scheduling activities within Outlook
The Microsoft Dynamics CRM calendar synchronizes with Outlook’s calendar.
When you schedule activities in Outlook, you can track those activities in
Microsoft Dynamics CRM. Then, when you are looking at a record in CRM,
you’ll see all of the activities relevant to that record.

Task A Tracking Outlook tasks in CRM
Anytime you are editing a task in Outlook, you should see a Track button on
the toolbar or ribbon. Clicking this button will automatically track the
Outlook task in your corporate Microsoft Dynamics CRM system.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane on the left, click the Tasks option.
2. Your Outlook To-Do List will appear.
3. Locate the Type a new task field. In this field, type the subject of your task

and press Enter to add the task to your To-Do List for today.
4. Double-click the task to edit its properties.
5. In the CRM area of the ribbon, click the Track button.
6. Click the Set Regarding button and choose a record for this task. In

Microsoft Dynamics CRM, the task will now be associated with the
regarding record.

7. Click the Save & Close button.

Tracked Outlook tasks will be
viewable by another Microsoft
Dynamics CRM user who has access
to the regarding record. (The
regarding record is the record
associated with the task.)
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Task B Tracking Outlook appointments in CRM
You have an appointment scheduled with Jane Doe. Jane is a contact in
Microsoft Dynamics CRM. When you send the meeting invitation to Jane,
click the Set Regarding button to track this appointment on Jane’s contact
record in CRM. When you do this, the appointment will be available in the
Activities section of Jane’s contact record.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane on the left, click the Calendar option.
2. Your Outlook calendar will appear.
3. Create a new activity on the calendar. There are many ways to do this, but

the easiest is to click on a timeslot or day and just start typing.
4. Double-click the activity to bring up its properties.
5. Click the Track button, or click the Set Regarding button and choose a

record for this activity. In Microsoft Dynamics CRM, the activity will now
be associated with the regarding record.

6. Click the Save & Close button.

Once an activity is tracked with a
record in Outlook, you’ll see the
following text appear at the top of
the appointment: [CRM] Regarding:
<RecordName>
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Sending e-mails within Outlook
If you use Outlook to send e-mail, you can track relevant e-mails in Microsoft
Dynamics CRM. Then, when you are looking at a record in CRM, a copy of
the e-mails will display in the History section of the record.

Task A Tracking a new Outlook e-mail in CRM
When you are creating a new message in Outlook, you can click the Set
Regarding button on the ribbon or toolbar to associate the e-mail with a record
in CRM. There’s also a Track button on the ribbon or toolbar. If the e-mail
address for the e-mail matches with a customer in CRM, you may also be able
to click the Track button to attach the e-mail back to a record in CRM.

Outlook 2003/2007/2010:
1. Click the New button on the Outlook toolbar and create a new e-mail

message.
2. Enter the e-mail address for your recipient. Add a subject and message

body as well, just as you would do with any normal e-mail.
3. Click the Track button.
4. If you want to associate the e-mail with a specific record, you can click the

Set Regarding button and manually associate the e-mail with someone
other than the email recipient or any CRM entity.

5. In Microsoft Dynamics CRM, go to your contact record for the recipient
of the e-mail. Double-click the contact to bring up details for the record.

6. On the left, click the History option. You should see a record of the e-mail.
Double-click it to bring up a saved copy of the e-mail.

When looking at e-mail history for a
record, check your filter. By default,
you’ll only see e-mails sent in the last
30 days, but that filter is easy to
change. Just click the Filter drop-down
at the top of the contact history
screen.
E-mails stored in Microsoft Dynamics
CRM are separate from e-mails stored
in your Exchange server. If space
limitations require you to remove
messages from your Sent Items folder
in Outlook, the e-mail will still appear
in Microsoft Dynamics CRM.
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Task B Tracking an incoming Outlook e-mail
in Microsoft Dynamics CRM

If you highlight a message in your Outlook Inbox, clicking the Track button in
the ribbon or toolbar will copy the message to the History section of the
sending contact’s record in Microsoft Dynamics CRM. This is a great way to
share important e-mails with your colleagues without actually giving them full
access to your inbox.

Outlook 2003/2007/2010/Internet Explorer:
1. In your Inbox or other mail folder, go to a message that you’d like to track

in Microsoft Dynamics CRM.
2. Click the Track button. The message will be promoted to Microsoft

Dynamics CRM, and you will now see a copy of the message in the
Completed Activities section of the contact that sent the e-mail.

3. If you want to associate the e-mail with another contact or other type of
record, click the Set Regarding button and choose a different record.

You can highlight multiple e-mails in
Outlook and click the Track button to
track all highlighted e-mails at once.
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Task C Sending template-based e-mails in
Outlook

If you want to use a CRM template but are sending the e-mail from within
Outlook, then you can insert a CRM direct e-mail template into the message.
Before you insert a template into an e-mail message, make sure you’ve tracked
it back to a CRM record first.

Outlook 2010/Internet Explorer:
1. Create a new e-mail message in Outlook.
2. Enter your recipient’s e-mail address into the To field, and select a

regarding record (by clicking Track or Set Regarding on the CRM tab of
the ribbon) for the e-mail.

3. Click the Insert Template drop-down and select the More E-mail
Templates option.

4. Select an e-mail template and click OK.

If the Insert Template button is grayed
out, you may need to click the Track
button.
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Task D Attaching Sales Literature to an
outgoing e-mail

A marketing team might want to send out a sales literature document to
promote a new product. In CRM, you can attach sales literature to an e-mail
just like any other attachment.

Outlook 2010:
1. Create a new e-mail message in Outlook.
2. Click the Attach Sales Literature button.
3. Select a sales literature document and click OK.

Remember to track the e-mail in CRM
before you attach a sales literature
document.
This feature is only available for
Outlook 2010 users.
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Converting Outlook e-mails
A new customer sends you an e-mail message. This customer isn’t in CRM yet.
With just a couple of clicks, you can convert that e-mail message into an
opportunity, contact, and more within CRM.

Task A Converting an e-mail to an
Opportunity

Many opportunities will come to you through e-mail. An existing customer
might send you a message with a request for more work. A new prospect might
first contact you by e-mail. It’s pretty common for an e-mail message to be the
first place where you learn about an opportunity, and when that happens, you
should convert the e-mail to an opportunity in CRM.

Outlook 2010:
1. In your Inbox (or other folder), highlight an e-mail message.
2. In the CRM group of the ribbon, click the Convert To drop-down.
3. Choose Opportunity.
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Task B Converting an e-mail to a case
A customer might send you an e-mail message about a problem he or she is
having with something that your company sells. You want the customer service
department to deal with the issue, so you convert the e-mail message to a case.

Outlook 2010:
1. In your Inbox (or other folder), highlight an e-mail message.
2. In the CRM group of the ribbon, click the Convert To drop-down.
3. Choose Opportunity.

Once the e-mail has been converted
to a case, the originating e-mail will
automatically be attached to the case.
So, the customer service rep who
handles the case will be able to see
the message that your customer
originally sent.
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Managing goals
Every organization has goals. A salesperson might need to generate $30,000 of
revenue in a quarter. A service technician might be required to close 15 service
cases every week. In CRM, you can create and track goals for employees in
your organization.

Task A Creating “amount” goal metrics (Step 1)
For a monetary goal, you would use an “amount” goal metric. You might, for
example, want a salesperson to generate a certain amount of revenue in closed
opportunities within a specified period. Before you can create a goal for this
salesperson, you would need to create a revenue goal metric.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Service and then Goal Metrics.
2. On the Goal Metrics tab, in the

Records group of the ribbon,
click the New button.

3. Give your metric a name, and
then, in the Metric Type field,
select the Amount option.

4. Click the Save & Close button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Service and then Goal Metrics.
2. On the Goal Metrics menu click

the New button.
3. Give your metric a name, and

then, in the Metric Type field,
select the Amount option.

4. Click the Save & Close button.

Now that you’ve created your goal
metric, you’ll need to add rollup
queries to your goal. The rollup
queries define your targets for this
goal and they are covered in Task C.
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Task B Creating “count” goal metrics (Step 2)
With “count” goal metrics, you can track progress by a record count. A service
technician, for example, might need to close a certain number of service cases
in a week. Before you create a goal like this for a service technician, you would
need to create a goal metric that tracks by count.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Service and then Goal Metrics.
2. On the Goal Metrics tab, in the

Records group of the ribbon,
click the New button.

3. Give your metric a name, and
then, in the Metric Type field,
select the Count option.

4. Click the Save & Close button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Service and then Goal Metrics.
2. On the Goal Metrics menu, click

the New button.
3. Give your metric a name, and

then, in the Metric Type field,
select the Count option.

4. Click the Save & Close button.

Consider using “count” goal metrics
to track user adoption. Set specific
goals for the number of new
activities, the number of new
opportunities, the number of 
new records, etc. In your dashboards,
you can then display user progress
toward these goals.
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Task C Creating rollup queries (Step 3)
The rollup query defines the subset of records that will be used for counting
progress toward your goals. For example, you might create a rollup query that
defines just high-priority opportunities. Once you have that query in place,
then you can create a goal for closing x number of high-priority opportunities.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Sales and then Rollup Queries.
2. On the Rollup Queries tab, in

the Records group, click the New
button.

3. Give your rollup query a name
and entity type.

4. Once you select an entity type, a
query edit window will appear,
where you can configure your
query logic.

5. Click the Save & Close button
when you are done.

Outlook 2003/2007:
1. In the Navigation Pane, click

Sales and then Rollup Queries.
2. On the Rollup Queries menu,

click the New button.
3. Give your rollup query a name

and entity type.
4. Once you select an entity type, a

query edit window will appear,
where you can configure your
query logic.

5. Click the Save & Close button
when you are done.

Click the View Records button at the
bottom of the query to see if your
search yields any results.
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Task D Creating individual goals (Step 4)
Once you have defined your goal metrics and your rollup queries, you’re now
ready to put actual goals into the system. As a manager, you can create goals for
your employees or you can create personal goals for yourself.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Sales and then Goals.
2. On the Goals tab, in the Records

group of the ribbon, click the
New button.

3. Give your goal a name, goal
metric, and owner.

4. Define the time period for this
goal.

5. Define your target, which will be
either an integer or monetary
amount, depending on your goal
metric.

6. Define your criteria for the goal,
including your rollup query.

7. Click the Save & Close button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Sales and then Goals.
2. On the Goals menu, click the

New button.
3. Give your goal a name, goal

metric, and owner.
4. Define the time period for this

goal.
5. Define your target, which will be

either an integer or monetary
amount, depending on your goal
metric.

6. Define your criteria for the goal,
including your rollup query.

7. Click the Save & Close button.

If you are creating goals for a large
number of users, consider using the
workflow feature to speed up the
process of creating individual user
goals.
Use the Parent Goal field to define
multiple sub-goals that roll up into
one bigger master goal.
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Creating and editing opportunities
Opportunities are potential sales. Whether you are selling widgets, services,
buildings, pizzas, or just about anything else, you can customize the opportu-
nity feature in Microsoft Dynamics CRM to track the sales opportunities for
your company.

Task A Creating a new opportunity
Adding a new opportunity to Microsoft Dynamics CRM is the first step in
managing your prospective sales. You can create a new opportunity from the
New Record drop-down on the File tab of the ribbon in Internet Explorer, or
you can follow the procedure below.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click on

Sales and then Opportunities.
2. On the Opportunities tab in the

Records group of the ribbon,
click the New button.

3. Enter information about your
opportunity.

4. Click the Save & Close button.

Outlook 2003/2007:
1. In the Navigation Pane, click on

Sales and then Opportunities.
2. On the Opportunities menu,

click the New button.
3. Enter information about your

opportunity.
4. Click the Save & Close button.

From anywhere in Microsoft Dynamics
CRM, you can choose the Opportunity
option from the New Record drop-
down to create a new opportunity.
While you are editing an opportunity,
you can print information for the
opportunity by clicking the Print
Preview button on the File tab. If you
don’t see it, you might have to first
save the opportunity. Click the blue
floppy disk icon to save.
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Task B Adding products to an opportunity
Microsoft Dynamics CRM stores a central list of products. When you enter an
opportunity, it’s a good idea to link products to the opportunity. Doing so
makes it easy to calculate the estimated revenue and create quotes, orders, and
invoices for the opportunity. It also makes it easy to create product-based
reports.

Outlook 2003/2007/2010/Internet Explorer:
1. Create a new opportunity or open an existing opportunity.
2. If you are creating a new opportunity, click the Save button after entering

the required fields.
3. On the left, click on the Line Items form Section.
4. Specify a price list.
5. Choose a product and unit, and quantity. (The amount will be automati-

cally calculated when you save.)
6. Click the Save & Close button.
7. The product will be added to the opportunity. Note that this also changes

the estimated revenue field for the opportunity.
8. Click the Save & Close button.

The estimated revenue for an
opportunity will be automatically
calculated if you add products to the
opportunity. So, if you add two
products valued at $15 each to the
opportunity, the overall estimated
revenue for the opportunity will 
show as $30.
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Task C Editing an existing opportunity
From the Opportunity list view, you can double-click any opportunity to edit
the properties of the opportunity. Of course, you’ll need to have sufficient
permissions to edit the opportunity.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Sales and then Opportunities.
2. This will bring up your default list of your opportunities.
3. Locate the opportunity you’d like to edit. Use the Search for Records field

at the top of the Opportunities list to find a specific opportunity.
4. Double-click the opportunity you’d like to edit.

To easily find a specific opportunity,
use your views. When looking at the
list of opportunities, you’ll see the
View drop-down at the top. Choose a
view, and only opportunities matching
the view will appear.
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Task D Closing an opportunity
Once an opportunity has been won or lost, you can close the opportunity in
Microsoft Dynamics CRM. It’s a good idea to close your opportunities when
they’re no longer active because this removes them from your active list of
opportunities in the Opportunity list view.

Outlook 2003/2007/2010/Internet Explorer:
1. Go to your Opportunities list.
2. Double-click an opportunity to open it for editing.
3. In the Actions group of the ribbon, click the Close as Won or Close as Lost

button.
4. Choose a status for the opportunity to show whether the opportunity was

won or lost.
5. Select a reason for the end of the opportunity.
6. Add an actual revenue, close date, competitor, and description.
7. Click OK.

Once you have closed an opportunity,
it will be automatically removed from
the My Open Opportunities view. If
you want to view your closed
opportunities, choose the Closed
Opportunities view from the view
drop-down at the top of the
Opportunities list.
Workflow can be used to automate
activity creation and opportunity
record updates to support a sales
process before/after closing the
opportunity.
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Tracking competitors
Gaining an understanding of your competition is critical to understanding
whether your sales and marketing efforts are working. By creating a central list
of competitors in Microsoft Dynamics CRM, you can track your win/loss rate
with specific opportunities and products.

Task A Managing the list of competitors
The first step in tracking your competitors in Microsoft Dynamics CRM is to
create a list of competitors. Once your list of competitors has been defined,
you can link those competitors to opportunities or products.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Sales and then Competitors.
2. On the ribbon in the Records

group, click the New button.
3. Type the name of your

competitor in the Name field.
4. Enter any other information

about your competitor into the
other fields on the screen.

5. Click the Save & Close button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Sales and then Competitors.
2. On the Competitors menu, click

the New button.
3. Type the name of your

competitor in the Name field.
4. Enter any other information

about your competitor into the
other fields on the screen.

5. Click the Save & Close button.

You’ll probably want to add products
to your competitors. Understanding
which products are sold by your
competitors is important—especially
if you are in a highly competitive sales
environment.
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Task B Creating a relationship between a
competitor and an opportunity

After adding an opportunity to Microsoft Dynamics CRM, you may find out
that you’re competing against a specific competitor. When you learn this, asso-
ciate the opportunity with the competitor.

Outlook 2003/2007/2010/Internet Explorer:
1. Create a new opportunity or open an existing opportunity.
2. If you are creating a new opportunity, click the Save button after entering

the required fields.
3. On the left, click the Competitors option.
4. On the ribbon in the Records group, click the Add Existing Competitor

button.
5. In the look up dialog, add any existing competitors to the opportunity.
6. Click OK.
7. Click the Save & Close button.

One of the reports included in
Microsoft Dynamics CRM is the
Competitor Win Loss report. In the
Navigation Pane, click Sales and then
Competitors. In the Data group of the
ribbon, click the Reports drop-down
and choose the Competitor Win Loss
option.
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Using sales literature
Sales slicks, pricing spreadsheets, product descriptions, technical documents,
news bulletins, manuals, marketing collateral, and any other sales literature can
all be added to the sales literature library in Microsoft Dynamics CRM.

Task A Adding sales literature
After adding sales literature to the library in Microsoft Dynamics CRM, you
can associate the literature with products or competitors. Then, the next time
you are up against a specific competitor, you’ll have literature specific to the
competitor at your fingertips. If you’re selling a product, the price lists, news,
or marketing collateral is linked to the product and is easily accessible.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Sales and then Sales Literature.
2. On the Sales Literature tab, in

the Records group of the ribbon,
click the New button.

3. Give your sales literature item a
title and subject. Fill in any other
fields.

4. Click the Save button.
5. On the left, click the Sales

Attachments option.
6. On the Actions toolbar, click the

New Sales Attachment button.
7. Add a title, author, keywords,

and abstract (description). Click
the Browse button to attach a
file.

8. Click the Save & Close button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Sales and then Sales Literature.
2. On the Sales Literature menu,

click the New button.
3. Give your sales literature item a

title and subject. Fill in any other
fields.

4. Click the Save button.
5. On the left, click the Sales

Attachments option.
6. On the Actions toolbar, click the

New Sales Attachment button.
7. Add a title, author, keywords,

and abstract (description). Click
the Browse button to attach a
file.

8. Click the Save & Close button.

Click the Documents option instead of
the Sales Attachments if your
document is in a SharePoint folder.
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Task B Viewing sales literature
Sales literature that is linked with products or competitors can be viewed in the
Sales Literature section for the product or opportunity. If you’d like to view all
sales literature, check out the Sales Literature view.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Sales and then Sales Literature. That will

bring up the master list of all sales literature.
2. When viewing the details for a product, click the Sales Literature option on

the left to bring up sales literature associated with the product.
3. At the top of the Sales Literature list, click the View drop-down to select a

category of literature to display.

In the master list of sales literature,
you can switch views to show specific
types of sales literature. In the top-
right corner of the Sales Literature
view, click the View drop-down to see
your views. (You can create views by
clicking the Advanced Find button.)
When viewing the details for a
competitor, click the Sales Literature
option on the left to bring up sales
literature linked with that competitor.
Use the Search for Records field at the
top of the Sales Literature list to find
a specific document.
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Opportunity reporting
At the end of the day, opportunity reports will really drive your sales system.
Reports will show your most important competitors, your best-selling prod-
ucts, and your most productive salespeople.

Task A Exporting opportunities to Excel
Many people overlook Excel as a reporting tool. It can, however, be a really
powerful tool. If you don’t know anything about pivot charts and pivot tables
in Excel, run a Windows Live Search or reference your favorite Excel book.
Using pivot tables, you can easily create breakdowns of your sales data. Want to
know how many sales you have broken down by state and then salesperson?
That report takes about ten seconds to produce as a pivot table.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Sales and then Opportunities.
2. Choose a view from the View

drop-down.
3. In the Data group of the ribbon,

click the Export to Excel button.
4. Select the type of export to

perform. You can export a static
worksheet, or you can create a
dynamic pivot table or work-
sheet.

5. Click the Export button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Sales and then Opportunities.
2. Choose a view from the View

drop-down.
3. On the Opportunities menu,

click the Export to Excel button.
4. Select the type of export to

perform. You can export a static
worksheet, or you can create a
dynamic pivot table or work-
sheet.

5. Click the Export button.

When exporting to Excel, you have
three export options:
■ Static worksheet with records from

this page: Exports the data that you
see on the screen.

■ Dynamic PivotTable: Automatically
creates a PivotTable from the data
that is exported to Excel. In Excel,
you’ll see a Refresh from CRM
button that will bring new data
from Microsoft Dynamics CRM
using the live data in your
database.

■ Dynamic Worksheet: With this
option, you get the same dynamic
worksheet that you get with the
PivotTable option above, but
without the PivotTable
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Task B Running opportunity reports
Without any customization, you can create activity, competitor, lead source
effectiveness, and pipeline reports in Microsoft Dynamics CRM. Using the
Report Wizard, you can create new reports that show data specific to your
business process.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Sales and then Opportunities.
2. Select the opportunities that

should be included in your
report. (This step is optional.)

3. On the Opportunities tab, in the
Data group of the ribbon, click
the Run Report drop-down.

4. Select the report you’d like to
run.

5. Choose the range of records that
should be included in the report.
Your options are: All applicable
records, The selected records, and
All records on all pages in the
current view.

6. Click the Run Report button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Sales and then Opportunities.
2. Select the opportunities that

should be included in your
report. (This step is optional.)

3. On the toolbar, click the Run
Report drop-down.

4. Select the report you’d like to
run.

5. Choose the range of records that
should be included in the report.
Your options are: All applicable
records, The selected records, and
All records on all pages in the
current view.

6. Click the Run Report button.

To select all opportunities, click the
checkmark field right under the New
button.
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Working with activities in Microsoft
Dynamics CRM
In this chapter, you’ll learn how to manage activities within the web-based
Microsoft Dynamics CRM application. Most users use Outlook to manage
their calendars on a day-to-day basis, so be sure to read Chapter 5, which
covers basic activity functions within Outlook.

Task A Viewing the calendar in Microsoft
Dynamics CRM

The Activities list view shows a listing of activities (appointments, tasks, service
activities, e-mails, etc.) in a spreadsheet-like format. You can filter this list to
show just specific activities, and you can use the View drop-down to configure
pre-defined sets of activities based on a query. Both activities created in the web
client and Outlook (if tracked in CRM) will appear in this list.

To view activities in Microsoft Dynamics CRM:
1. In the Navigation Pane, click Workplace and then Activities.
2. Your CRM activities list will appear.
3. Double-click any activity to open it for editing.
4. Use the drop-downs at the top of the Activity list to filter the activities that

appear in the list.

Not all of your Outlook activities will
appear in the Microsoft Dynamics
CRM activities list. Only Outlook
activities that have been selected to
be tracked in CRM will appear.
Activities added to Microsoft
Dynamics CRM will also show up 
in your Outlook calendar if you have
the Outlook client installed.
In the Navigation Pane, click
Workplace and then Calendar.
This will show you a calendar of 
your CRM activities.
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Task B Viewing activities linked with a record
in Microsoft Dynamics CRM

Activities in Microsoft Dynamics CRM are usually linked with records. You
might schedule an appointment with a contact, send an e-mail to an account,
or set a task for an opportunity. When you are looking at any record, you’ll see
an activities option in the left panel. In this area, you’ll see all activities linked
to the record.

To view activities linked with a record:
1. In the Navigation Pane, click Sales and then Contacts.
2. Double-click a contact to open it for editing.
3. On the left, click the Activities option.
4. A list of activities that have been associated with the record will appear.
5. Use the filter at the top of the screen to set the date range for activities in

the list.

Activities are associated with a record
when that record is specified as the
“Regarding” record. This can be done
when scheduling activities in
Microsoft Dynamics CRM or Outlook.
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Task C Creating a new appointment
You can create an appointment in Outlook, and that appointment will sync to
Microsoft Dynamics CRM if you click the Track in CRM or Set Regarding
buttons in the ribbon or toolbar. Alternatively, you can follow this process to
create an appointment in the web client for Microsoft Dynamics CRM.

To create a new appointment:
1. In the Navigation Pane, click Workplace and then Activities.
2. On the Activities tab in the New group of the ribbon, click the New

button.
3. Select the type of activity you’d like to create. For this example, you will

create an appointment.
4. Click OK.
5. Enter the details for your appointment.
6. Click the Save and Close button.

You can also initiate this process from
the customer record so that contact
details are pre-populated.
Types of activities that can be
initiated from the Activities list:
■ Task
■ Fax
■ Phone Call
■ E-mail
■ Letter
■ Appointment
■ Service Activity
■ Campaign Response
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Task D Creating a new task
Any new tasks created in Outlook will automatically sync to Microsoft
Dynamics CRM if you click the Track in CRM or Set Regarding buttons on
the toolbar or ribbon in Outlook. If you are in the web client for Microsoft
Dynamics CRM, you can use this process to create a new task.

To create a new task:
1. From the New Activity drop-down on the File tab, choose the Task option.
2. Give your task a subject, and type any details.
3. In the Regarding field, select the record for association with this task.
4. Click the Save & Close button.

To view your task list: In the
Navigation Pane, click Workplace and
then Activities. From the Type drop-
down at the top of the screen, choose
the Tasks option.
When you are viewing any record in
Microsoft Dynamics CRM, click the
Activities button on the left to bring
up a list of activities associated with
the record. Click the New button to
create a new task associated with the
record.
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Task E Scheduling a recurring appointment
If you have an appointment that recurs on a specific date and time, then you
can create a recurring appointment. Once you create a recurring appointment,
pending appointments will be subsequently created. If you delete a recurring
appointment, you will be prompted to delete either the occurrence or series of
appointments.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Workplace and then Activities.
2. On the Activities tab, in the New

group, click the Appointment
drop-down, and then select the
Recurring Appointment option.

3. Configure your recurring
appointment.

4. Click the Save & Close button
when you are done.

Outlook 2003/2007:
1. In the Navigation Pane, click

Workplace and then Activities.
2. On the Activities menu, high-

light Appointment, and then
select the Recurring
Appointment option.

3. Configure your recurring
appointment.

4. Click the Save & Close button
when you are done.

Recurring activities will also show up
in your Outlook calendar as recurring
activities if you configure your CRM
appointments to sync down to
Outlook.
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Converting activities
Converting an activity in CRM is similar to converting other kinds of records
in your system. Activities can be closed or converted into another CRM record
type, such as an opportunity. This will allow you to track sales processes with
activities in CRM.

Task A Closing an activity
Once an activity has been completed, you can clear it to show that the activity
is done. Doing so takes the activity off your list of active activities. Completed
activities will appear in the Closed Activities area for a record, while active
activities show in the Activities area.

To close an activity:
1. In the Navigation Pane, click Workspace and then Activities.
2. Double-click an activity (like an appointment) to open it for editing.
3. In the Actions group of the ribbon, click the Close Appointment button.
4. Select a status for the appointment. For example, you could choose

Completed or Cancelled.
5. Click OK.

You could create a workflow to
automatically close activities after a
certain period of time.
Closed activities show in the Closed
Activities area for a record.
In the Activity list view, one of your
views (in the drop-down in the upper-
right corner) will show a list of your
completed activities.
A quick way to complete an activity is
to save it as completed. After double-
clicking any activity, click the Mark
Complete button in the Save group of
the ribbon.
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Task B Converting an appointment to an
opportunity

You complete a cold call, and the potential customer is excited about the
opportunity to work with your company. Converting an appointment to an
opportunity will automatically create a new opportunity, and it will change the
appointment status to complete. Most types of activities (e-mails, phone calls,
faxes, letters, appointments, and campaign responses) can be converted. Service
activities and tasks cannot be converted.

To convert an appointment to an opportunity:
1. In the Navigation Pane, click Workspace and then Activities.
2. Double-click an activity to open it for editing.
3. In the Convert Activity group of the ribbon, click the To Opportunity

button.
4. Click the To Opportunity option.
5. Select a customer and source campaign.

You can also convert an appointment
to a case. Do this in situations where
follow-up support is required.
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Creating a campaign
The campaign feature in Microsoft Dynamics CRM lets you create a group of
marketing activities in an organized format from which you can easily run
reports.

Task A Creating a new campaign
If you are about to introduce a new product offering, you might create a new
campaign to advertise the offering. The campaign might consist of a number 
of planning tasks, mass letters, mass e-mails, postcards, phone calls, and more.
By creating a campaign for this marketing effort, you can create a structure
that allows for tracking the progress of the campaign.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Marketing and then Campaigns.
2. On the Campaigns tab in the

Records group of the ribbon,
click the New button.

3. Give your campaign a name and
click the Save button.

4. Enter information into the other
fields for the campaign.

5. On the left, you can set up plan-
ning tasks, campaign activities,
and campaign responses. All of
these are covered later in the
chapter.

6. Click the Save and Close button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Marketing and then Campaigns.
2. On the Campaigns menu, click

the New button.
3. Give your campaign a name and

click the Save button.
4. Enter information into the other

fields for the campaign.
5. On the left, you can set up plan-

ning tasks, campaign activities,
and campaign responses. All of
these are covered later in the
chapter.

6. Click the Save and Close button.

In the Campaign list view, click the
Excel to Excel button to export a list
of all marketing lists currently
showing.
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Task B Creating a campaign template
There’s not much difference between a campaign and a campaign template.
Functionally, they’re the same. A campaign is a collection of tasks and activities
related to a marketing effort. So is a campaign template. You’d create a
template, however, as an example marketing campaign to be used as the basis
for other campaigns. In other words, in the future, you can create a new
campaign from a campaign template, and the structure of the template is
copied to the new campaign.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Marketing and then Campaigns.
2. On the Campaigns tab in the

Records group of the ribbon,
click the New Template button.

3. Give your campaign template a
name and click the Save button.

4. Enter information into the other
fields for the campaign.

5. On the left, you can set up plan-
ning tasks, campaign activities,
and Target Marketing Lists. All
of these are covered later in the
chapter.

6. Click the Save and Close button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Marketing and then Campaigns.
2. On the Campaigns menu, click

the New Template button.
3. Give your campaign template a

name and click the Save button.
4. Enter information into the other

fields for the campaign.
5. On the left, you can set up plan-

ning tasks, campaign activities,
and Target Marketing Lists. All
of these are covered later in the
chapter.

6. Click the Save and Close button.

To view just the campaign templates,
choose the Campaign Templates view
from the View drop-down in the
upper-right corner of the Campaign
list view.
To create a new campaign from a
template, open the template. Then, in
the Actions group of the ribbon, click
the Copy as Campaign button.
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Adding items to a campaign
After creating a campaign, you’ll want to add planning tasks and campaign
activities to the campaign. If you have a template already created, the easiest
way to do this is to add the existing template to your campaign.

Task A Adding a planning activity to a
campaign

Planning activities are often the key to a successful campaign. Planning activi-
ties are the activities that you need to perform before your first communication
with the customer takes place. Examples of planning tasks might be:

■ Finalize the target marketing lists.

■ Get bids from the printer for your sales slicks.

■ Get approval for the marketing materials to be sent.

■ Have the design department create special landing pages on your
website.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Marketing and then Campaigns.
2. Double-click a marketing campaign to open it.
3. Click the Planning Activities option on the left.
4. In the Records group of the ribbon, click the Add New Activity drop-

down, then select an activity type.
5. Repeat steps 3 and 4 until all of your planning tasks have been added.
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Task B Adding a campaign activity to a
campaign

Campaign activities are the customer interactions that are all tied to the
campaign. Campaign activities can include letters, e-mails, trade shows, adver-
tisements, phone calls, and just about any other type of sales activity.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Marketing and then Campaigns.
2. Double-click a marketing campaign to open it.
3. Click the Campaign Activity option on the left.
4. In the Records group of the ribbon, click the Add New Campaign Activity

button.
5. Enter details for the activity.
6. Click the Save and Close button.

If you are adding a mail merge
campaign activity, all records in your
marketing list must be the same
entity. So, they’d all have to be
contacts, or they’d all have to be
accounts. They could not be a mix of
contacts and accounts.
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Task C Adding a marketing list or product to
a campaign

You probably won’t target your entire database for every part of every
campaign. Because of this, you can target specific campaign activities to just
contacts that are in specific marketing lists.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Marketing and then Campaigns.
2. Double-click a marketing campaign to open it.
3. Click the Target Marketing Lists option on the left.
4. In the Records group of the ribbon, click the Add Existing Marketing List

button and click OK.
5. Check the box to add the marketing lists to open undistributed campaign

activities. Click OK.

When you are adding a marketing list
in the Target Marketing Lists area,
click the New button to create a 
new list.
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Quick campaigns
Quick campaigns are like mini campaigns that you run without significant
planning. Where campaigns might be made up of many planning tasks and
campaign activities, quick campaigns only contain one activity. If you want to
send a mass e-mail to everyone in a marketing list, for example, you can run a
quick campaign for those contacts to send the e-mails.

Task A Creating a quick campaign
You can create a quick campaign from just about any list view of customer
data. In the accounts, leads, and contacts views, you’ll see a Create Quick
Campaign button on the Actions toolbar. After completing an Advanced Find,
you also have an option to run a quick campaign for the results of the search.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Sales and then Contacts. (You
can create quick campaigns on
other record types as well.)

2. Highlight the contacts that
should be included in the quick
campaign. (You might switch to
a different view or run an
Advanced Find to make it easier
to narrow down your list of
contacts.)

3. On the Add tab in the Marketing
group of the ribbon, click the
Create Quick Campaign drop-
down and select a range of
contacts. (Selected records, All
records on the current page, or
All records on all pages.)

4. Click Next.
5. Give your campaign a name and

click Next.
6. Choose the type of activity,

assign ownership to a user in the
system, and click Next.

7. Add details for your activity and
click Next.

8. Click the Create button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Sales and then Contacts. (You
can create quick campaigns on
other record types as well.)

2. Highlight the contacts that
should be included in the quick
campaign. (You might switch to
a different view or run an
Advanced Find to make it easier
to narrow down your list of
contacts.)

3. On the Record menu, highlight
Create Quick Campaign drop-
down and select a range of
contacts. (Selected records, All
records on the current page, or
All records on all pages.)

4. Click Next.
5. Give your campaign a name and

click Next.
6. Choose the type of activity,

assign ownership to a user in the
system, and click Next.

7. Add details for your activity and
click Next.

8. Click the Create button.

You can assign quick campaign
activities to:
■ The currently logged-in user
■ The owners of each record in the

quick campaign
■ A specific user or queue
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Campaign responses
Campaign responses track the effectiveness of a campaign. A campaign
response is the record in Microsoft Dynamics CRM that tracks the type of
response a customer has to a campaign. Reports are included that track
campaign responses, so it’s easy to make sure your team knows how a customer
has responded to your campaign.

Task A Creating a campaign response
You can create a campaign response manually from within the Campaign edit
screen. It’s important to understand that the campaign response that gets
created through this process only notes within Microsoft Dynamics CRM that
a customer has responded to your campaign. Unless a workflow has been
created, campaign responses do not send any sort of communication to the
customer.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Marketing and then Campaigns.
2. Double-click a campaign to open it for editing.
3. On the left, click the Campaign Responses option.
4. In the Records group of the ribbon, click the Add New Campaign

Response button.
5. Enter the details of your campaign response.
6. Click Save and Close.

This task shows you how to manually
record a campaign response. In many
circumstances, however, the response
will be automatically generated.
Here’s how:
■ You can convert an existing activity

to a campaign response.
■ You can import campaign activities

from a spreadsheet.
■ You can automatically generate

campaign responses with scripting
or workflow.
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Task B Duplicating a campaign response
If you get the same response from a dozen contacts at the same company that
were included in a campaign, you can duplicate their response.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Marketing and then Campaigns.
2. Double-click a campaign to open it for editing.
3. Click the Campaign Responses option on the left.
4. Double-click the campaign response you’d like to copy.
5. In the Action group of the ribbon, click the Copy Campaign Response

button.
6. A copy of the campaign response will appear. Make any changes.
7. Click Save and Close.
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Task C Converting campaign responses to
leads or opportunities

If someone responds to your marketing campaign, and if they are interested in
buying one of your products or services, it’s a good idea to convert that
campaign response to a lead or opportunity. Once the marketing group within
your company has gotten the campaign response, they can convert the
response to a lead, and then the sales department takes over.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click Marketing and then Campaigns.
2. Double-click a campaign to open it for editing.
3. Click the Campaign Responses option on the left.
4. Double-click the campaign response you’d like to convert.
5. In the Actions group of the ribbon, click the Convert Campaign Response

button.
6. Choose to convert to a new lead, an existing lead, or a new record for a

customer.
7. Click OK.

If you convert the campaign response
to a new record for an existing
customer, a new quote, order, or
opportunity is automatically created
and associated with the customer you
choose.
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Task D Closing a campaign response
If a customer included in your campaign makes it clear that he or she is not
interested in your product or service, you can close the campaign response.
Closing the campaign response does not convert it to a lead, opportunity, or
any other sort of record. It simply disqualifies the response.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Marketing and then Campaigns.
2. Double-click a campaign to open it for editing.
3. Click the Campaign Responses option on the left.
4. Open a campaign response you’d like to close.
5. In the Actions group of the ribbon, click the Close Campaign Response

button.
6. Choose a status (either Closed or Cancelled) and click OK.

At any point, you can reactivate a
campaign response. Just highlight the
campaign response. In the Records
group of the ribbon, click the Activate
button.
Closed campaign responses are read-
only and cannot be edited unless they
are reactivated.
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Creating marketing lists
Marketing lists are groups of otherwise unrelated records. You could use
marketing lists to collect a list of customers that should be included in a
campaign. You might have a marketing list of your top prospects. You might
even keep everyone on your Board of Directors in a marketing list.

Task A Creating a static marketing list
You can create a marketing list that includes accounts, contacts, or leads.
Create a marketing list of records if you ever want to include the records in a
campaign or quick campaign.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Marketing and then Marketing
Lists.

2. On the Marketing Lists tab in
the Records group of the ribbon,
click the New button.

3. Give your marketing list a name.
4. Choose an entity from the

Member Type drop-down. (You
can create a marketing list for
contacts, accounts, or leads.)

5. Add any other field information
to your marketing list.

6. Click the Save and Close button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Marketing and then Marketing
Lists.

2. On the Marketing Lists menu,
click the New button.

3. Give your marketing list a name.
4. Choose an entity from the

Member Type drop-down. (You
can create a marketing list for
contacts, accounts, or leads.)

5. Add any other field information
to your marketing list.

6. Click the Save and Close button.

It’s easy to export marketing list
members to Excel. Look for the Excel
button in the Data group of the
ribbon.
You can change the columns that
display for your marketing list by
creating a new marketing list view.
This is done in the Advanced Find
interface. See Chapter 4 for
information on creating a new view.
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Task B Creating a dynamic marketing list
Unlike a static marketing list, a dynamic marketing list is based on Advanced
Find criteria. This means that once you create a dynamic marketing list, you
won’t need to personally manage membership of the list.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Marketing and the Marketing
Lists.

2. On the Marketing Lists tab, in
the Records group, click the New
button.

3. In the General form section,
select Dynamic as the marketing
list type.

4. Give your marketing list a name
and member type and click the
Save button.

5. On the left, click the Marketing
List Members Option, then click
the Manage Members button in
the Actions group of the ribbon.

6. Configure your query and click
the Use Query button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Marketing and the Marketing
Lists.

2. On the Marketing Lists menu,
click the New button.

3. In the General form section,
select Dynamic as the marketing
list type.

4. Give your marketing list a name,
a member type, and then click
the Save button.

5. On the left, click the Marketing
List Members Option, then click
the Manage Members button in
the Actions group of the ribbon.

6. Configure your query and click
the Use Query button.

If the Marketing List Members option
on the left is grayed out, then you
may need to save your marketing list.
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Task C Activating/deactivating a marketing
list

New marketing lists entered into Microsoft Dynamics CRM are not active
until you activate them. Only active marketing lists can be used in quick
campaigns or campaigns, and you’ll need to activate a marketing list before you
can add members.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Marketing and then Marketing
Lists.

2. Highlight the marketing list you’d
like to activate or deactivate.

3. On the Marketing Lists tab in
the Records group of the ribbon,
choose either the Activate or
Deactivate option.

Outlook 2003/2007:
1. In the Navigation Pane, click

Marketing and then Marketing
Lists.

2. Highlight the marketing list you’d
like to activate or deactivate.

3. On the Marketing Lists menu,
choose either the Activate or
Deactivate option.

In the top corner of the Marketing
Lists view, check out the View drop-
down. By default, you’ll probably see
My Active Marketing Lists. If a
marketing list is not active, it will not
appear in this list. To see your inactive
marketing lists, use this View drop-
down to select a view that includes
inactive lists.
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Managing list membership
Once you have the marketing list created, your first step will probably be to
add members to the list. You can add leads, accounts, or contacts to a
marketing list.

Task A Adding records to a marketing list
There are three basic ways to add records to a marketing list. You can import
records directly into a marketing list. Using the Advanced Find feature, you
can specify that any resulting records be added to the marketing list. You can
also use the lookup feature to add marketing list members individually.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Marketing and then Marketing Lists.
2. Double-click the marketing list whose membership should be changed.
3. On the left, click the Marketing List Members option.
4. In the Actions group of the ribbon, click the Manage Members button.
5. Select a method for finding your members. You can use a simple lookup or

Advanced Find. Click OK.
6. Find your records and add them to the marketing list.

Marketing lists can have accounts,
leads, or contacts as members.
If your campaign needs to send an e-
mail to a marketing list that contains
both contacts and leads, you’ll have
to create two separate marketing lists.
One for the relevant contacts, and the
other for the relevant leads.
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Task B Copying membership for another
marketing list

Last year, you created a marketing list for contacts that received a holiday card.
This year, you want to create another holiday card marketing list, but it might
save some time to just copy last year’s list. This way, you can start with a larger
list and just add the new relevant contacts that have been added in the last 12
months.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Marketing and then Marketing
Lists.

2. Highlight a marketing list.
3. On the Marketing Lists tab in

the Actions group of the ribbon,
click the Copy to Marketing List
button.

4. Click the New button to create a
new marketing list, if necessary.

5. Highlight a marketing list and
click OK.

6. Click OK to confirm that you
would like all marketing list
members to be copied to the 
new list that you highlighted in
step 5.

Outlook 2003/2007:
1. In the Navigation Pane, click

Marketing and then Marketing
Lists.

2. Highlight a marketing list.
3. On the Marketing Lists menu,

click the Copy to Marketing List
button.

4. Click the New button to create a
new marketing list, if necessary.

5. Highlight a marketing list and
click OK.

6. Click OK to confirm that you
would like all marketing list
members to be copied to the 
new list that you highlighted in
step 5.
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Task C Removing records from a marketing
list

If you’ve added a contact to a marketing list, and you find out that working
with that contact will not be possible, you can remove him or her from the
marketing list. Doing so will pull the contact out of any campaigns or quick
campaigns that use the marketing list.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Marketing and then Marketing Lists.
2. Double-click the marketing list whose membership should be changed.
3. On the left, click the Marketing List Members option.
4. In the Actions group of the ribbon, click the Manage Members button.
5. Choose the Use Advanced Find to remove the member’s option and 

click OK.
6. Configure your Advanced Find, and click the Find button to see the results.
7. Highlight any contacts you’d like to remove and click the Remove from

Marketing List button.

After clicking the Marketing List
Members option, choose the Remove
from Marketing List option in the
Actions group of the ribbon to quickly
remove the selected members.
For more information about using the
Advanced Find feature, see Chapter 4.
Removing records from a marketing
list does not remove the records from
the database. It simply disassociates
the record from the list. Rest assured
you won’t lose any data.
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Running a mail merge
With the mail merge features in Microsoft Dynamics CRM, you can easily
create multiple letters, envelopes, or labels for customers in your database. 
If you’ve used the mail merge features in Microsoft Word, you’ll find this 
interface is very similar. To utilize Microsoft Dynamics CRM’s integration 
with Microsoft Word, you’ll need to have the CRM Outlook client installed 
on your local computer.

Task A Selecting recipients for a mail merge
There are a number of ways to select recipients for a mail merge, but most of
them involve either selecting a view that contains the relevant records or
performing an Advanced Find. As long as you can bring up your recipients on
a page, running a mail merge for them should only require a couple of clicks.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Sales and then Contacts. (You
could also mail merge to other
entities, but for this example,
we’ll use contacts.)

2. From the View drop-down in the
upper-left corner of the contact
list, choose the view that contains
the contacts that should be
included in the mail merge.

3. Once the view is displayed, high-
light the contacts that should be
included in the mail merge.

4. On the Create Related tab in the
Marketing group of the ribbon,
click the Mail Merge button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Sales and then Contacts. (You
could also mail merge to other
entities, but for this example,
we’ll use contacts.)

2. From the View drop-down in the
upper-left corner of the contact
list, choose the view that contains
the contacts that should be
included in the mail merge.

3. Once the view is displayed, high-
light the contacts that should be
included in the mail merge.

4. On the Add menu, click the Mail
Merge button.
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Task B Executing a mail merge
When you execute a mail merge in Microsoft Dynamics CRM, data from
CRM is sent directly to Microsoft Word. Once you’re in Word, the mail merge
process is the same as you’d follow for creating any mail merge in Word.

Outlook 2010/Internet Explorer:
1. Highlight the records that should

be included in your merge. (See
the previous task.)

2. On the Create Related tab in the
Marketing group of the ribbon,
click the Mail Merge button.

3. From the drop-down at the top,
choose the Letter option.

4. Select a template.
5. Select a merge range of records.

(Selected records, All records on
current page, or All records on all
pages.)

6. Click OK. If prompted, click
Open to open the Word docu-
ment.

7. In Word, click the CRM button
on the toolbar or ribbon.

8. Your mail merge will begin in
Word.

Outlook 2003/2007:
1. Highlight the records that should

be included in your merge. (See
the previous task.)

2. On the Add menu, click the Mail
Merge button.

3. From the drop-down at the top,
choose the Letter option.

4. Select a template.
5. Select a merge range of records.

(Selected records, All records on
current page, or All records on all
pages.)

6. Click OK. If prompted, click
Open to open the Word docu-
ment.

7. In Word, click the CRM button
on the toolbar or ribbon.

8. Your mail merge will begin in
Word.

After clicking the Word icon to launch
the merge, click the Data Fields
button to select the fields that will be
available.
You will need to enable macros to run
a mail merge using Word.
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Task C Printing labels for customers
You can print on just about any type of label in Microsoft Word. If a standard
Avery (or other) template doesn’t exist for the sheet of labels you’re using, you
can create a custom label.

Outlook 2010/Internet Explorer:
1. Highlight the records that should

be included in your label merge.
2. On the Create Related tab in the

Marketing group of the ribbon,
click the Mail Merge button.

3. From the drop-down at the top,
choose the Labels option.

4. Select an existing label template,
or start with a blank document.

5. Select a merge range of records.
(Selected records, All records on
current page, or All records on all
pages.)

6. Click OK. If prompted, click
Open to open the Word 
document.

7. [If prompted…] In Word, click
the CRM button on the toolbar
or ribbon.

8. Follow the Mail Merge Wizard
instructions in Word to complete
your label merge.

Outlook 2003/2007:
1. Highlight the records that should

be included in your label merge.
2. On the Add menu, click the Mail

Merge button.
3. From the drop-down at the top,

choose the Labels option.
4. Select an existing label template,

or start with a blank document.
5. Select a merge range of records.

(Selected records, All records on
current page, or All records on all
pages.)

6. Click OK. If prompted, click
Open to open the Word 
document.

7. [If prompted…] In Word, click
the CRM button on the toolbar
or ribbon.

8. Follow the Mail Merge Wizard
instructions in Word to complete
your label merge.

If you print on a specific label often,
it’s probably a good idea to create a
template specifically for that label.
Label mail merge templates can
include pictures, so you could include
your specific formatting, return
address, or other relevant information
within the template.
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Task D Printing envelopes for customers
Using the mail merge feature in Microsoft Dynamics CRM, you can merge
envelopes. Doing this saves you the time of sticking labels on an envelope,
since the customer information in your database is printed directly on the
envelope.

Outlook 2010/Internet Explorer:
1. Highlight the records that should

be included in your merge. (See
the previous task.)

2. On the Create Related tab in the
Marketing group of the ribbon,
click the Mail Merge button.

3. From the drop-down at the top,
choose the Envelope option.

4. Select a template, or choose to
start with a blank document.

5. Select a merge range of records.
(Selected records, All records on
current page, or All records on all
pages.)

6. Click OK. If prompted, click
Open to open the Word 
document.

7. [If prompted…] In Word, click
the CRM button on the toolbar
or ribbon.

8. Follow the Mail Merge Wizard
instructions in Word to complete
your envelope merge.

Outlook 2003/2007:
1. Highlight the records that should

be included in your merge. (See
the previous task.)

2. On the Add menu, click the Mail
Merge button.

3. From the drop-down at the top,
choose the Envelope option.

4. Select a template, or choose to
start with a blank document.

5. Select a merge range of records.
(Selected records, All records on
current page, or All records on all
pages.)

6. Click OK. If prompted, click
Open to open the Word 
document.

7. [If prompted…] In Word, click
the CRM button on the toolbar
or ribbon.

8. Follow the Mail Merge Wizard
instructions in Word to complete
your envelope merge.

For more information about
completing your mail merge once it
opens in Word, see the help section in
Word or refer to your favorite
Microsoft Word book.
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Creating mail merge templates in
Microsoft Word
Mail merge templates are created in Microsoft Word, but they can be uploaded
to Microsoft Dynamics CRM so that they are available anytime you need to
merge customer information. There are two basic types of templates: personal
templates and organization templates.

Task A Creating personal templates
Personal templates are Microsoft Word mail merge templates that are only
available when you are logged into Microsoft Dynamics CRM. Other users
will not be able to see your personal templates.

Outlook 2003/2007/2010/Internet Explorer:
1. Highlight the records that should be included in your merge. (See the

previous task.)
2. On the Create Related tab in the Marketing group of the ribbon, click the

Mail Merge button.
3. From the drop-down at the top, choose the Envelope option.
4. Select a template, or choose to start with a blank document.
5. Select a merge range of records. (Selected records, All records on current

page, or All records on all pages.)
6. Click OK. If prompted, click Open to open the Word document.
7. Follow the steps to create your mail merge.
8. In the final step, click the Upload Template to CRM option.
9. Give your template a name and click the Save button.

Only XML files can be uploaded and
used as mail merge templates with
Microsoft Dynamics CRM. If your
template is saved as a DOC, DOCX, or
other format, open it in Word and
save it as an XML file.
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Task B Making templates available to the
entire organization

Organization templates are shared with all Microsoft Dynamics CRM users, so
you should only share templates that will be relevant to everyone in your
company. To create an organization template, you’ll follow the same process
discussed in the previous task. In the list of mail merge templates, you’ll choose
to make the template available to others.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings, Templates, and then Mail Merge

Templates.
2. Highlight the template you’d like to make available to the organization.

(You may need to switch views to see the template.)
3. On the toolbar, choose the Make Available to Organization option from

the More Actions drop-down.

On the toolbar, choose the Make
Personal option from the More
Actions drop-down to revert an
organization template to be just
viewable by yourself.
If you make a template available to
the organization, you can restrict
access to users or teams. Highlight the
template from your list of mail merge
templates. On the toolbar, choose the
Sharing option from the More Actions
toolbar.
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Sending e-mail
E-mail is the most commonly used method of business communication today,
and Microsoft Dynamics CRM makes it easy to send e-mail through Outlook
or via the web-based Microsoft Dynamics CRM client. However you send e-
mails, it’s easy to attach them back to records—giving you a valuable history of
communication on the record level.

Task A Sending a template-based
direct e-mail

If you are using the web client for Microsoft Dynamics CRM, you can send 
e-mails to your customers right from within Internet Explorer. E-mails sent
from Microsoft Dynamics CRM will come from your e-mail address, and a
history of the e-mail having been sent will be created on the customer record.
Best of all, they’re sent using templates, so you’ll save time writing the body of
the e-mail.

Outlook 2010/Internet Explorer:
1. On the Navigation Pane, click

Sales and then Contacts. (You
could also click Leads or
Accounts, if you wanted to send
an e-mail to a lead or account.)

2. From your contact list, highlight
the contact (or contacts) that
should receive the direct e-mail.

3. In the Collaborate group of the
ribbon, click the Send Direct E-
mail button.

4. In the template list, choose a
template.

5. Select a range of recipients. You
can send to Selected records, All
records on the page, or All
records.

6. Choose a sender for your e-mail.
The e-mail will appear to have
been written by the sender or
queue that you select.

7. Click Send.

Outlook 2003/2007:
1. On the Navigation Pane, click

Sales and then Contacts. (You
could also click Leads or
Accounts, if you wanted to send
an e-mail to a lead or account.)

2. From your contact list, highlight
the contact (or contacts) that
should receive the direct e-mail.

3. On the Contacts menu, click the
Send Direct E-mail button.

4. In the template list, choose a
template.

5. Select a range of recipients. You
can send to Selected records, All
records on the page, or All
records.

6. Choose a sender for your e-mail.
The e-mail will appear to have
been written by the sender or
queue that you select.

7. Click Send.

After clicking the Send Direct E-mail
button, you’ll have the option to send
the template-based e-mail to:
■ The selected records on the current

page
■ All records on the current page
■ All records on all pages
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Task B Viewing a history of e-mail sent or
tracked through CRM

In the History area of a record, you’ll see a list of all completed activities for 
the record—including histories of e-mails sent. If you need to refer back to an
e-mail conversation you had with a client, it’ll be faster to refer back to the
client’s record. Once you start using this feature, you’ll never spend hours
pouring through your Sent Items folder to find a relevant message.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, go to the record whose history you’d like to view.

For example, you could click Sales in the Navigation Pane and then
Customers.

2. Double-click a record from your list.
3. On the left, click the Closed Activities option.
4. A list of all e-mails sent should appear. Double-click any e-mail to see the

full contents of the e-mail, including attachments.

E-mails tracked in Microsoft Dynamics
CRM will show a tracking token next
to the subject in the closed activities
area of the customer record. You can
turn off the tracking token feature, in
which case CRM uses smart matching
technology to figure out where to
store the message.
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Sending e-mails to multiple recipients
Using the mass e-mail features in Microsoft Dynamics CRM, you can send
template-based e-mails to multiple contacts in one step. The e-mails can
contain field placeholders that will pull data from the customer record, so your
customers will never know that they are receiving a mass e-mail.

Task A Selecting multiple e-mail recipients
To select mass e-mail recipients, you can either highlight contacts in a view, or
you can use the Advanced Find feature to isolate specific contacts. You could
also send a mass e-mail to members of a marketing list.

Outlook 2003/2007/2010/Internet Explorer:
1. Go to a list of customer records. Using the View drop-down, select the

view that contains the customers who should be in your distribution list.
2. Perform the mass e-mail using the instructions on the next page.

~or~

1. Go to a list of customer records. Hold down the Ctrl key and highlight
records that should be included in the distribution list.

2. Perform the mass e-mail using the instructions on the next page.

If you send a lot of mass e-mails,
check out CoreMotives. CoreMotives
is an e-mail marketing service that
makes it a lot easier to send and track
the progress of your e-mail campaigns
(www.coremotives.com).
Before you start mass e-mailing
customers, run a Bing Search (or other
internet search) on “avoiding
blacklisting” to get updated
information about blacklist sites. If
you continually send SPAM-like e-
mail, you may get blacklisted, and
then many of your customers will stop
receiving your e-mails altogether.
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Task B Sending an e-mail to multiple
recipients

Mass e-mails are a type of campaign, and the easiest way to send a mass e-mail
on-the-fly is to use the quick campaign feature. Quick campaigns are covered
in more depth in Chapter 8.

Outlook 2010/Internet Explorer:
1. Highlight all of the records that

should be included in your mass
e-mail. (See the previous page for
options.)

2. On the Add tab, in the
Marketing group of the ribbon,
click the Mail Merge button.

3. Choose E-mail as your mail
merge type.

4. Choose a template or a blank
document to start with.

5. Click OK.
6. In Word, follow the Mail Merge

Wizard. In the last step, you will
have the option to send the
message via e-mail.

Outlook 2003/ 2007:
1. Highlight all of the records that

should be included in your mass
e-mail. (See the previous page for
options.)

2. On the Add menu, click the Mail
Merge option.

3. Choose E-mail as your mail
merge type.

4. Choose a template or a blank
document to start with

5. Click OK.
6. In Word, follow the Mail Merge

Wizard. In the last step, you will
have the option to send the
message via e-mail.

When sending mass e-mails, make
sure that you are compliant with the
CAN-SPAM law. It may be worth
consulting with your attorney for
SPAM regulations within your state. In
some states, you can lose your
business license if enough people
complain about your unsolicited 
e-mails.
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Workflow e-mails
Automated workflow in Microsoft Dynamics CRM allows you to monitor for
events and condition changes within the database and then perform specific
actions in reaction. Before attempting this task, make sure you read Chapter
18, where we talk about workflow in more detail.

Task A Configuring workflow to
automatically send e-mails

As soon as a new lead is entered into the system, you want to set Microsoft
Dynamics CRM to automatically send an e-mail to the relevant sales rep to let
him or her know that a lead is ready in the system. Using the workflow feature,
it’s easy to set this up.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings and then Processes.
2. On the Actions toolbar, click the New button.
3. Give your Process a name, choose Lead as your entity, and select Workflow

as your Category type.
4. Click OK.
5. With the default settings, the workflow will be configured to run each time

a new lead is created.
6. On the Actions toolbar, click the Add Step drop-down and choose the

Send E-mail option.
7. Type the description of your step, and click the Properties button to

configure the e-mail. This is where you’ll add the From and To contacts,
subject, and body of the e-mail message.

8. Click Save and Close to exit the e-mail properties.
9. Click Save and Close to exit the workflow screen.

Workflows are not active until they
are activated. Open the workflow and
click the Activate button on the
toolbar to make it active.
When adding a recipient to your
workflow e-mail, use the Form
Assistant to add dynamic values. So,
in the To: field, you could send the e-
mail to the Lead’s owner. The resulting
text will look like this: {Owner(Lead)}.
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Creating contracts
If you use Microsoft Dynamics CRM to manage your customer support, 
you can create contracts in the system. Those contracts are tied to a specific
company record, and the contract is a collection of contract lines. Each
contract line defines a specific service or offering that the customer is entitled
to under the contract. Support cases can be tied to contracts in situations
where an organization doesn’t want to extend any support to customers with
expired or insufficient support entitlements.

Task A Creating a new contract template
All new contracts are based off a contract template. If you offer a dozen base
support agreements, you can create contract templates for each of your offer-
ings. Then, when one of your users creates a new contract in the system, the
billing frequency, allotment type, and service hours will be pre-filled for the
user.

Outlook 2003/2007/2010/ Internet Explorer:
1. In the Navigation Pane, click Settings and then Templates.
2. Click the Contract Templates option.
3. On the Actions toolbar, click the New button.
4. Give your contract template a name, billing frequency, abbreviation, allot-

ment type, and calendar service hours.
5. Click the Save and Close button.

After they have been created, contract
templates cannot be edited. If you
need to make changes to a contract
template, create a new template and
delete the old template.
If you need to delete multiple contract
templates, choose the Bulk Delete
option from the More Actions drop-
down.
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Task B Creating a new contract
A contract is an agreement between you and your end customer to provide a
specific service (or services) within the valid dates for the contract. If you offer
a customer a technical support plan, use the contract feature to record the
specifics of that contract.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Service and then Contracts.
2. On the Actions toolbar, click the New button.
3. Choose a template and click OK.
4. Give your contract a name, start date, end date, and currency. Add the

linked customer and bill-to customer.
5. Add any other information.
6. Click the Save and Close button.

A good best practice is to start this
process from the customer record so
that customer information (in step 4)
is pre-populated.
Only draft contracts can be edited.
Once you activate a contract, it is no
longer editable. The same applies for
contracts where the customer has
been invoiced.
When adding a contract to the
system, make sure you record the
billing address for the customer. You’ll
need that billing address to create
invoices for the contract.
Once you have created a contract,
you’ll need to add contract lines.
(See Task C.)
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Task C Creating a new contract line
Contract lines are the specific items that show what your company is offering
to provide the end customer under the contract. If you are using contracts to
manage your technical support agreements, you might add contract lines for
100 hours of telephone support, 25 hours of on-site support, and 1,000 e-mail
support responses. All three of these lines comprise your support agreement.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Service and then Contracts.
2. Double-click the contract you’d like to edit.
3. On the left, click the Contract Lines option.
4. In the Records group of the ribbon, click the New Contract Line button.
5. Give your contract line a title, start/end date, number of cases/minutes,

and total price.
6. Add any other information to the contract line and click the Save and

Close button.

Contracts without any contract lines
cannot be invoiced.
Use the Search field at the top of the
contracts list to find a specific
contract.
Active contract lines cannot be
deleted. If you would like to remove
an active line from a contract, you
should cancel the line.
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Working with contracts
Once the base structure of your contract is created, you can activate the contracts,
send invoices to your customers, and modify or renew contracts as needed.

Task A Activating and invoicing a contract
When the customer has agreed to purchase your support contract, you should
send an invoice for the contract. Sending an invoice automatically changes the
status to active. The invoice that gets created will show up in your list of
invoices. Microsoft Dynamics CRM does not actually produce invoices for
clients, but it can track whether an invoice is paid. This is a manual process,
unless your CRM system is linked with an ERP system. Many customers use
an integration broker like Pervasive or Scribe to integrate CRM with their
accounting or ERP systems.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Service and then Contracts.
2. Double-click the contract you’d

like to invoice/activate.
3. In the Actions group of the

ribbon, click the Invoice
Contract button.

4. Click the Close button.
5. To see the invoice, click Sales in

the Navigation Pane and then
Invoices.

Outlook 2003/2007:
1. On the toolbar, click the New

Record drop-down and select a
record type.

2. Enter field data for your account.
3. Click the Save & Close button.

A service case can deduct from the
number of hours on a contract when
the case is resolved.
Invoiced contracts cannot be deleted.
They can be canceled, which is
covered on the next page.
Consider integrating workflow into
your contract process. For example,
you could configure workflow to
watch for activated contracts. As soon
as a contract is activated, workflow
could automatically send an e-mail to
the customer explaining support
hours, telephone numbers, and other
important information.
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Task B Canceling a contract
If an active contract is no longer needed, you can cancel the contract. A
customer may have moved to a different service, or perhaps the customer has
invoked your money-back guarantee on services. Either way, cancelling the
contract removes it from the active contracts list.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Service and then Contracts.
2. Double-click the contract you’d like to invoice/activate.
3. In the Actions group of the ribbon, click the Cancel Contract button.
4. Enter a cancellation date. The contract will no longer be active as of this

date.
5. Click OK.

If the contract is still in draft status,
you can delete it. Until the point
where you invoice a contract, it can
be deleted, but after the contract has
been invoiced, you would cancel it.
You can also put a hold on a contract.
Open the contract for editing, and
then choose the Hold Contract option
in the Actions group of the ribbon.
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Task C Renewing a contract
The support you offered was so great last year that the customer wants to
renew his or her support contract. They’re essentially looking for the same
service, so you’ll save data entry time by renewing the existing contract, rather
than creating a new contract from scratch.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click Service and then Contracts.
2. Double-click the contract you’d like to renew. (Only active/invoiced

contracts can be renewed.)
3. In the Actions group of the ribbon, click the Renew Contract button.
4. Select whether to include cancelled contract lines, if there are any, and 

click OK.
5. Update information for the contract—like the start date and end date.
6. To activate the contract, choose the Invoice Contract option from the

Actions drop-down on the toolbar.
7. Click Save and Close.

If you want to renew a contract, the
contract end date must have passed.
Only expired contracts can be
renewed. If you try to renew a
contract that has not yet expired, it
will show in draft (non-active) mode
until the original contract end date.
If you renew a contract, the Contract
ID is retained from the original
contract.
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Creating cases
Using the case management features in Microsoft CRM, you can manage your
customer service department. Cases can be linked to customer records, and they
also interact with other parts of the application—like contracts, knowledge-base
articles, services, and activities.

Task A Creating a new case
If a customer calls with a problem or concern, you can create a new case for the
situation. The system will automatically assign a case number, and you can
write in information about the case—like the subject, owner, title, and level of
customer satisfaction. Cases remain open in the system until they are closed by
one of your support technicians, and it is easy to run reports that show
outstanding cases.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Service and then Cases.
2. On the Cases tab in the Records

group of the ribbon, click the
New button.

3. Give your case a title, customer,
subject, and owner.

4. You can also link the case with a
contract and/or contract line.

5. Click Save and Close.

Outlook 2003/2007:
1. In the Navigation Pane, click

Service and then Cases.
2. On the Cases menu, click the

New button.
3. Give your case a title, customer,

subject, and owner.
4. You can also link the case with a

contract and/or contract line.
5. Click Save and Close.

It’s a good idea to link new cases to
contract lines. If the contract line
allows for five support incidents, then
this case would count as one of them.
To assign a case to another user or
queue, open the case. In the
Collaborate group of the ribbon, click
the Assign button.
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Task B Entering notes for a case
Many cases have unique circumstances, and to house that special information,
you can enter notes for any case. An unlimited number of notes can be added
to each case, and if you are taking over a case, it’s always a good idea to review
the notes before talking with the customer.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Service and then Cases.
2. Double-click a case from the list of cases.
3. Click the Notes and Article form section.
4. In the Notes area, click where it says Click here to enter a new note….
5. Type your note.
6. Click Save and Close.

Use the Quick Find field at the top of
the list of cases to find a specific case.
When you print the details for a case,
you see all field information for the
case, along with the notes and
relevant knowledge-base articles. Just
click the Print Preview button on the
File tab.
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Working with cases
Once cases are created, you can assign ownership for the case, resolve the case
when the client has been satisfied, and track relevant information as the case
progresses through your support process.

Task A Assigning cases to other CRM users 
or queues

After entering a new case in the system, you can assign the case to another
CRM user or queue. Let’s say you are a level 1 technician. You take all of the
information about the customer’s problem over the phone, but you cannot
resolve the issue. To escalate the case to a level 2 technician, you could assign
the case to the level 2 queue.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Service and then Cases.
2. Double-click a case from the list of cases.
3. In the Collaborate group of the ribbon, click the Assign button.
4. Choose the Assign to another user or team option.
5. Click the Lookup button to explore your list of users and teams.
6. Highlight a user or team and click OK.
7. Click OK, and then Save and Close.

Depending on your security settings,
you may lose the ability to perform
certain actions once you change
ownership for a case. For example, if
your security settings prohibit editing
other users’ cases, you wouldn’t be
able to edit the case after transferring
ownership.
To create a queue, click Settings in the
Navigation Pane and then Business
Management. Then, click the Queues
option to create new queues or
modify existing ones.
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Task B Resolving cases
After the customer has been satisfied, you can mark the case as resolved in the
system. You’ll want to make sure to resolve cases as soon as they are closed to
avoid having the case mistakenly show up in the Neglected Cases report.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Service and then Cases.
2. Double-click a case from the list of cases.
3. In the Actions group of the ribbon, click the Resolve Case button.
4. Specify the Resolution Type, Resolution, Total Time, and Total Billable

Time for the case.
5. Add a description, if necessary.
6. Click OK.

You can also delete or cancel cases.
After opening the case for editing,
you’ll see options to either delete the
case or cancel it in the Save group of
the ribbon.
You cannot resolve a case until all
activities associated with the case
have been marked complete.
Resolved cases are read-only and
cannot be edited unless they are
reactivated.
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Task C Reactivating cases
You’re on the phone with a customer, and he is satisfied with the solution
you’ve offered him, so you mark the case as resolved. However, an hour later,
the customer calls back and is having the same issue again. In this case, you
would reactivate the existing case.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Service and then Cases.
2. From the View drop-down, choose a view that will include your resolved

cases. For example, you could choose the My Resolved Cases view.
3. Double-click the resolved case you’d like to reactivate.
4. In the Actions group of the ribbon, click the Reactivate button.
5. Click OK.

To see all active cases associated with
a record, open the record. To do this
with a contact record, click Sales on
the Navigation Pane and then
Contacts. Double-click a contact
record. On the left, click the Cases
option, and you’ll see a list of cases
that are associated with the contact.
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Task D Assigning a knowledge base article 
to a case

A customer calls with a specific issue, but it’s an issue that has previously been
documented in your knowledge base. By assigning the knowledge base article
to the case, you can easily see the contents of the article within the case screen,
and any other technicians that view the case will have the article for reference.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Service and then Cases.
2. Double-click a case from the list of cases.
3. Click the Notes and Article form section.
4. In the Knowledge Base Article section, click the Lookup button to browse

for a specific knowledge-base article.
5. From the drop-down in the upper-right corner, select a search method. Enter

your search terms, and click the Search button to find relevant articles.
6. Highlight the article that is relevant to the case, and click OK.

After clicking the Show article
checkbox, a toolbar will appear. Click
the E-mail KB Article button on that
toolbar, and you can easily e-mail the
document to a colleague or customer.
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Task E Running a neglected cases report
In any business, some customer service issues slip through the cracks. The
neglected cases report is designed to keep that from happening. The report will
show cases that have not been contacted recently. The report will show a list of
cases that have not had changes to the case or related activities/notes within the
time range you specify.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Service and then Cases.
2. If you want to run the report on

a sub-set of your cases, switch to
a view that just contains the cases
for your report. Alternatively, you
could Ctrl+ click to highlight
certain records, or you could run
an Advanced Find.

3. On the Cases tab in the Data
group of the ribbon, click the
Run Reports button.

4. Choose the Neglected Cases
report.

5. Select to run the report on all
records, the selected records, or
all records in the current view.

6. Click the Run Report button.
7. The graph that appears shows the

number of cases grouped by the
number of days neglected. Click
the Show All link at the bottom
of the graph to see the raw data.

Outlook 2003/2007:
1. In the Navigation Pane, click

Service and then Cases.
2. If you want to run the report on

a sub-set of your cases, switch to
a view that just contains the cases
for your report. Alternatively, you
could Ctrl+ click to highlight
certain records, or you could run
an Advanced Find.

3. On the Cases menu, click the
Run Reports button.

4. Choose the Neglected Cases
report.

5. Select to run the report on all
records, the selected records, or
all records in the current view.

6. Click the Run Report button.
7. The graph that appears shows the

number of cases grouped by the
number of days neglected. Click
the Show All link at the bottom
of the graph to see the raw data.

At the top of the report, you can
specify the minimum days neglected.
If you set this number to 7, for
example, the report will assume that
cases that have been open for 7 or
fewer days are not neglected, and
they will be omitted from the report.
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Creating articles
An articles library is a collection of technical documents, how-to’s, procedures,
bug fixes, and other documents. These documents are all meant to make it
easier to resolve customer service issues.

Task A Creating articles
Once you have solved a customer service or technical support issue, it’s a good
idea to document your solution process in the articles library. This way, the
next time a technician runs into the same issue with a customer, it will be
easier for him or her to efficiently resolve the issue.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Service and then Articles.
2. On the Articles tab in the

Records group of the ribbon,
click the New button.

3. Select a language, and then
choose from one of your existing
templates.

4. Click OK.
5. Add a title, subject, and

keywords for the article.
6. In the editing area, type the

content for this article.
7. Click Save and Close.

Outlook 2003/2007:
1. In the Navigation Pane, click

Service and then Articles.
2. On the Articles menu, click the

New button.
3. Select a language, and then

choose from one of your existing
templates.

4. Click OK.
5. Add a title, subject, and

keywords for the article.
6. In the editing area, type the

content for this article.
7. Click Save and Close.

Consider using a customer portal to
extend your CRM articles library to
non-CRM web users. The CRM Portal
Accelerator is free and available on
Codeplex.com. (Search for CRM.)
If you need a more advanced 
portal, check out ADX Studio
(www.adxstudio.com).
You can create article templates. This
will help provide uniformity in your
articles. In the Navigation Pane, click
Settings and then Templates. Then
click Article Templates.
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Task B Submitting an article for approval
Once you have written an article, it automatically is categorized in the Draft
queue. This allows you to make changes to it while you are investigating the
topic. When you are confident that the article is ready for publication, you can
submit it for approval.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Service and then Articles.
2. On the left, click the Drafts

queue.
3. Highlight the article you’d like to

submit for approval.
4. On the Articles tab in the

Actions group of the ribbon,
click the Submit button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Service and then Articles.
2. On the left, click the Drafts

queue.
3. Highlight the article you’d like to

submit for approval.
4. On the Articles menu, click the

Submit button.

Based on your security role, you may
also be able to publish the article. See
the next page for instructions.
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Task C Publishing a knowledge-base article
After a knowledge-base article has been submitted for approval, it is moved
into the Unapproved Articles view. From here, it can be either deleted or
approved. Until the article is approved, it will not become a part of the search-
able knowledge base.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Service and then Articles.
2. Click the view drop-down and

select the Unapproved Articles
option.

3. Highlight the article you’d like to
publish.

4. On the Articles tab in the
Actions group of the ribbon,
click the Approve button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Service and then Articles.
2. Click the view drop-down and

select the Unapproved Articles
option.

3. Highlight the article you’d like to
publish.

4. On the Articles menu, click the
Approve button.

Published articles are moved from the
Unapproved Articles view into the
Published Articles view.
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Task D Commenting on an article
If you use a knowledge-base article to resolve a customer’s issue, but you find
that the document is slightly out of date, you can add a comment to the
article. Comments appear in the Comments form section of the knowledge-
base article.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Service and then Articles.
2. Double-click a knowledge-base article to open it.
3. In the Actions group of the ribbon, click the Add Article Comment

button.
4. Add your comment, and click OK.

If you choose to e-mail the article,
comments will not be visible in the
version that is e-mailed.
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Searching and printing the articles
library
A knowledge base is a collection of technical documents, how-to’s, procedures,
bug fixes, and other documents. These documents are all meant to make it
easier to resolve customer service issues.

Task A Searching the articles library
If a customer calls with an issue, one of your first actions should be to search
the knowledge base to see if anyone else in your company has resolved the issue
and documented it. You can perform a keyword search, full text search, title
search, or article search.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Service and then Articles.
2. A list of articles should appear.
3. Click on the Search tab of the

ribbon. In the Options group,
you can configure your search.

4. In the Quick Find field, enter
your search terms and click the
search icon.

5. A list of matching articles should
appear.

Outlook 2003/2007:
1. In the Navigation Pane, click

Service and then Articles.
2. A list of articles should appear.
3. Click on the Search menu. Here

you can configure your search.
4. In the Quick Find field, enter

your search terms and click the
search icon.

5. A list of matching articles should
appear.
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Task B Printing articles
You may find it useful to print an article. Just like with most screens in
Microsoft Dynamics CRM, you’ll find a Print Preview button on the file tab.

Outlook 2003/2007/2010/Internet Explorer:
1. Double-click a relevant knowledge-base article to open it.
2. On the File tab, click the Print Preview button.
3. A print preview appears. Click the Print button.

If you have a PDF printer driver
installed, printing to PDF will let you
easily send the article to people
outside your company.
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Viewing the service calendar
The service calendar is a central area that you can use to schedule service-
related activities for any user in your organization. You can use the service
calendar to track appointments, service activities, conflicts, resources, and
other service-related items.

Task A Viewing the service calendar
Use the service calendar to quickly see available timeslots for scheduling
service-related activities or appointments. The service calendar keeps track of
when users are free, and it also tracks times when required resources, facilities,
and equipment are available for a service call.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Service and then Service Calendar.
2. The service calendar will appear.
3. On the left, you’ll see a list of resources.
4. In the middle, you’ll see a calendar view that shows service activities 

scheduled.
5. On the right, you’ll see a mini-calendar that you can use to switch the

middle panel to a different day.

Before using the service calendar, your
organization will need to have
services, resources,
facilities/equipment, and users
configured.
At the bottom of the middle column
(where you see the activities blocked
out), you can zoom and set a
begin/end date for activities that are
shown on the service calendar.
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Task B Filtering the service calendar
On the left panel of the service calendar, you see a list of items. These items
might be facilities, equipment, users, etc. In the middle column, you see all of
the service activities (using the items on the left) in their scheduled timeslot.
You can filter the service calendar to alter the items that are shown in the left
panel.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Service and then Service Calendar.
2. The service calendar will appear.
3. In the Type drop-down at the top of the service calendar, choose the type

of resources you’d like to see listed in the left panel of the service calendar.
4. In the View drop-down, you can further refine your filter. For example, if

you are showing the service calendar by Facility/Equipment, you can use
the View drop-down to show All Facilities/Equipment, Local
Facilities/Equipment, or Subsidiary Facilities/Equipment.

You can filter to show these types of
resources in the service calendar:
■ Appointment and Service Activity
■ Service Activity
■ Appointment
■ Resource
■ User
■ Facility/Equipment
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Task C Searching the service calendar
If you are looking for a specific resource, facility, or user, you can search within
the service calendar. At the top of the service calendar, you’ll see a Search
button, which performs a search to narrow the list of users and resources in the
left panel of the service calendar.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Service and then Service Calendar.
2. The service calendar will appear.
3. At the top of the screen, locate the Quick Find field.
4. Type your search term into this field and click the magnifying glass icon.

For example, you could type someone’s last name to see his or her avail-
ability on the service calendar.

When performing a search, you click
the magnifying glass icon to run the
search. After the search completes,
that icon changes to an X. Click the X
icon to clear your search results.
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Scheduling service activities and
appointments
You can use the service calendar to schedule a service-related activity or
appointment for anyone in your business unit or organization.

Task A Scheduling a new service activity
Service activities are different from other activities and appointments scheduled
in Microsoft Dynamics CRM. Service activities are tied to resources, and
because you schedule these activities on the service calendar, you’ll easily be
able to see where all of your service technicians are.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Service and then Service
Calendar.

2. The service calendar will appear.
3. In the New group of the ribbon,

click the Service Activity button.
4. In the Customers field, associate

the service activity with at least
one customer.

5. In the Service field, specify the
service to be performed.

6. In the Resources field, any
resources dependent on the
service selected will appear. You
could add additional resources, if
necessary.

7. Click the Find Available Times
button to see when the resources
are available.

8. Highlight a timeslot in the list of
available times, and click the
Schedule button.

9. Enter a subject for the activity,
and click the Save and Close
button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Service and then Service
Calendar.

2. The service calendar will appear.
3. On the Service Calendar menu,

click the Service Activity button.
4. In the Customers field, associate

the service activity with at least
one customer.

5. In the Service field, specify the
service to be performed.

6. In the Resources field, any
resources dependent on the
service selected will appear. You
could add additional resources, if
necessary.

7. Click the Find Available Times
button to see when the resources
are available.

8. Highlight a timeslot in the list of
available times, and click the
Schedule button.

9. Enter a subject for the activity,
and click the Save and Close
button.

Service activities that you own will
sync to your Outlook calendar, if you
have the Microsoft Dynamics CRM
Client for Outlook installed.
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Task B Rescheduling service activities
A client calls to say that they won’t be in the office when your service techni-
cian is scheduled to visit their office, so you need to reschedule the activity. Just
highlight the activity in the service calendar and click the Reschedule button to
move the activity to a different date or time.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Service and then Service
Calendar.

2. The service calendar will appear.
3. Click the activity you’d like to

reschedule.
4. In the Actions group, click the

Reschedule button.
5. Click the Find Available Times

button and choose a new time.
6. Click the Schedule button.
7. Click the Save and Close button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Service and then Service
Calendar.

2. The service calendar will appear.
3. Click the activity you’d like to

reschedule.
4. On the Service Calendar menu,

click the Reschedule button.
5. Click the Find Available Times

button and choose a new time.
6. Click the Schedule button.
7. Click the Save and Close button.

If you try to schedule two service
activities that require the same
resources at the same time, a dialog
box will appear warning you about
the conflict. You can override the
warning, or you can go back and
schedule at a time when all required
resources are available.
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Task C Creating a service activity for a case
If you’ve just entered a case for a customer service issue, you may want to create
a service activity so that someone within your organization can follow up to
resolve the case. You can easily schedule a service activity from within any case.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Service and then Cases.
2. Double-click the case for which you’d like to add a service activity.
3. On the left, click the Activities option.
4. In the records group of the ribbon, click the New Activity button.
5. Choose the Service Activity option and click OK.
6. Schedule the service activity. (See the previous two tasks for information on

scheduling service activities.)

By associating the service activity
with the case, you’ll be able to see the
activity each time you open the case.
It’ll show in the Activities section on
the left.
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Setting up services, resources,
and work hours
Before you can schedule service activities, you have to create a central list of
services. Also tied to your list of services will be dependent resources. So, for
example, if you have an onsite visit as a service, you may need to also have one
of your fleet of trucks available to perform that service.

Task A Creating services
Services are the general categories of activities that you perform for customers
as part of your support of those customers.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click on Service, and then Services.
2. A record list should appear.
3. On the ribbon in the Records group, click the New button.
4. Configure your service.
5. On the ribbon in the Save group, click the Save & Close button.

Service activities will sync to your
Outlook calendar if you are using
Microsoft Dynamics CRM with
Outlook.



161

Maximizing Your Sales with Microsoft Dynamics CRM 2011

Task B Assigning resources to services
You can assign resources to services. When doing so, you’ll create selection
rules and then assign resources for those selection rules. If you support three
products and only one of your support techs is qualified to answer questions
on product #1, you can create a simple selection rule that will require the tech
to be available when scheduling this service.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings and then Business Management.
2. Click the Services option.
3. Double-click the service from the list of services.
4. Click the Required Resources tab.
5. Create a selection rule, and assign resources to that rule.
6. Click the Save and Close button.

You can create very complex rules
governing which resources are
required for specific services. The
example given on this page shows a
very simple case, but this feature is
designed to grow into large
sophisticated support environments.
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Task C Managing service resource work
hours

Your employees are only available during certain hours. Facilities may only be
open during specific hours. Some equipment may not operate in off-hours
timeslots. By setting your service resource work hours, you’ll ensure that you
never schedule one of your service technicians when he or she is out of the
office.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings and then Business Management.
2. Click the Facilities/Equipment option.
3. Double-click a resource from the list that appears.
4. On the left, click the Work Hours option.
5. From the Set Up drop-down, you can configure a new weekly schedule, a

specific work schedule for one day, or a schedule of time off.
6. Double-click any day to modify the work schedule for that day.
7. Click OK and then Save and Close.

You can also set the work hours for
users in the database. In the
Navigation Pane, click Settings and
then Administration. Click the Users
option. Double-click the user whose
work hours you’d like to edit. On the
left, click the Work Hours option.
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Using the Import Data Wizard
You can perform most simple imports using the Import Data Wizard. This
tool, which is accessible both from within Outlook and in the Microsoft
Dynamics CRM web client, will import data into any entity from a CSV file.

Task A Importing a text file
Using the Import Data Wizard, you can import any CSV text file. Before
running an import job, it’s probably a good idea to open your data file in Excel
and check the actual data to make sure it is consistent with the existing data
and field structure in Microsoft Dynamics CRM.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Workplace and then Imports.
2. In the Records group of the

ribbon, click the Import Data
button.

3. Click the Browse button and
select your data file. Also, verify
the data and field delimiters. If
you are importing a CSV file, the
defaults should be fine. Click
Next.

4. In the Record type field, choose
the type of records you are
importing. In the Data map
field, choose a data map and
click OK. Click Next.

5. Choose a record owner and select
whether or not to import dupli-
cate records. Click Next.

6. Specify a name for the import
job, and click the Import button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Workplace and then Imports.
2. On the Imports menu, click the

Import Data button.
3. Click the Browse button and

select your data file. Also, verify
the data and field delimiters. If
you are importing a CSV file, the
defaults should be fine. Click
Next.

4. In the Record type field, choose
the type of records you are
importing. In the Data map
field, choose a data map and
click OK. (Creating a data map is
covered on the next page.) Click
Next.

5. Choose a record owner and select
whether or not to import dupli-
cate records. Click Next.

6. Specify a name for the import
job, and click the Import button.

If your data is in an Excel spread-
sheet, you can save it as a CSV file.
In Excel, click File | Save As. In the File
type drop-down, choose CSV (Comma
delimited).
CSV stands for Comma Separated
Values.
If you have a CSV file with columns
but empty data in the field, you will
get an error that columns / data do
not match.
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Task B Importing multiple files
In addition to importing a single file in, you can also import multiple files into
your CRM database. This is especially useful if you are importing a list of
contacts and accounts. If you import these lists at the same time, any contacts
and accounts that are linked to each other will be linked once they are
imported into your CRM database.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Workplace and then Imports.
2. In the Records group of the

ribbon, click the Import Data
button.

3. Click the Browse button and
select your data file. This should
be a ZIP file that contains your
multiple files.

4. In the Record type field, choose
the type of records you are
importing. In the Data map
field, choose a data map and
click OK. (Creating a data map is
covered on the next page.) Click
Next.

5. Choose a record owner and select
whether or not to import dupli-
cate records. Click Next.

6. Specify a name for the import
job, and click the Import button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Workplace and then Imports.
2. On the Imports menu, click the

Import Data button.
3. Click the Browse button and

select your data file. This should
be a ZIP file that contains your
multiple files.

4. In the Record type field, choose
the type of records you are
importing. In the Data map
field, choose a data map and
click OK. (Creating a data map is
covered on the next page.) Click
Next.

5. Choose a record owner and select
whether or not to import dupli-
cate records. Click Next.

6. Specify a name for the import
job, and click the Import button.

If you don’t import multiple files at
the same time, then linked records
won’t import properly. For example, if
you import a list of contacts that are
linked to an account that isn’t in your
system yet, then they won’t link to
any account.
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Task C Analyzing your import job
After your import job has finished, it’s a good idea to verify the records that
were imported. Just double-click the import job, and you’ll see a lists of records
that were successfully imported, as well as lists of items that were not imported.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Workplace and then Imports.
2. Double-click the import job you’d like to review.
3. On the left, click the <Records> Created option. If you imported contacts,

this will say Contacts Created. If you imported leads, it will say Leads
Created.

4. In this area, you’ll see a list of all records created as a result of the import.
5. On the left, click the Failures option. This will show a list of records that

were not imported for some reason. (Dealing with failures is covered later
in this chapter.)

When looking at the list of records
created, you can highlight all of them
and then click the Add to Marketing
List option to add all imported
contacts to a marketing list.
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Task D Dealing with failed import records
Sometimes during an import, certain records will not import properly. Maybe
they are missing data in a required field? If you are importing into a picklist
field, records might not import if the field value that you are importing does
not exist in the picklist. If you have chosen to not import duplicate records, the
import of a record might fail because the record already exists in Microsoft
Dynamics CRM.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Workplace and then Imports.
2. Double-click the import job you’d like to review.
3. On the left, click the Failures option.
4. A list of failed records will appear.
5. On the Actions toolbar, click the Export Error Rows button to export 

all of the records that were not imported to a CSV file for analysis in
Microsoft Excel.

Click the Print Preview button on the
File tab to create a print preview of
the records that were not properly
imported.
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Task E Deleting all records created by an
import

After running an import, you might realize that the import produced an unde-
sirable result. Maybe you forgot to import zip codes for contacts, or perhaps
some fields were mapped incorrectly? Whatever the issue, you can easily delete
all records associated with an import.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Workplace and then Imports.
2. Double-click the import job you’d like to review.
3. On the left, click the <Records> Created option. If you imported contacts,

this will say Contacts Created. If you imported leads, it will say Leads
Created.

4. In this area, you’ll see a list of all records created as a result of the import.
5. Highlight all records.
6. On the ribbon, click the Delete button.
7. Choose to either deactivate or delete the records.

To highlight all records in a list, click
the checkmark field in the upper-left
corner of the list.
You’ll have to delete the records 250
at a time if you delete using this
process. For large record sets, consider
using the bulk delete feature.
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Exporting data
There are many reasons for exporting your data from Microsoft Dynamics
CRM. You may need an offsite copy of the data, or you may need to export the
data for reporting purposes. You may need to export contact data to send to a
mailing house. It’s easy to export any part of your Microsoft Dynamics CRM
database.

Task A Exporting data to Excel
The easiest way to export a single entity is with the direct export to Microsoft
Excel. Whether you’re looking at contacts, leads, accounts, opportunities, cases,
or any other entity, you can click the Export to Excel button to export.

If you are using Microsoft Excel 2003,
spreadsheets are limited to 65,535
rows and 255 columns.

Outlook 2010/Internet Explorer:
1. Go to any list of records in

Microsoft Dynamics CRM. For
example, you could:
■ Click Sales in the Navigation

Pane and then Contacts to
bring up a list of contacts.

■ Click Sales in the Navigation
Pane and then Leads to bring
up a list of leads.

■ Click Service in the
Navigation Pane and then
Cases to bring up a list of
support cases.

2. Once you have a list of records
on the screen, click the Excel
button in the Data group of the
ribbon.

3. You will have the option to
export static or dynamic work-
sheets. You can also export a
dynamic pivot table.

4. Click the Export button.

Outlook 2003/2007:
1. Go to any list of records in

Microsoft Dynamics CRM.
2. Once you have a list of records

on the screen, click the Export to
Excel button on the Records
menu.

3. You will have the option to
export static or dynamic work-
sheets. You can also export a
dynamic pivot table.

4. Click the Export button.
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Task B Exporting data to Excel for cleanup
and re-import

You should use Excel whenever you are editing a large list of records. You can
edit multiple records in CRM, but editing in Excel is very quick and easy for
data cleanup. Once you have finished cleaning up your data in an Excel spread-
sheet, then you can simply save and re-import the file.

Outlook 2010/Internet Explorer:
1. Go to any list of records in

Microsoft Dynamics CRM.
2. Once you have a list of records

on the screen, click the Excel
button in the Data group of the
ribbon.

3. Select the static worksheet option
and check the option to make
the data available for re-
importing at the bottom of the
window.

4. Clean up your data in the Excel
spreadsheet.

5. Save your Excel spreadsheet as a
CSV file, then re-import the file
into CRM. Follow the importing
records steps that are covered
earlier in this chapter.

Outlook 2003/2007:
1. Go to any list of records in

Microsoft Dynamics CRM.
2. Once you have a list of records

on the screen, click the Export to
Excel button on the Records
menu.

3. Select the static worksheet option
and check the option to make
the data available for re-
importing at the bottom of the
window.

4. Clean up your data in the Excel
spreadsheet.

5. Save your Excel spreadsheet as a
CSV file, then re-import the file
into CRM. Follow the importing
records steps that are covered
earlier in this chapter.
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Using Excel exports for reporting
Don’t discount the reporting power in Microsoft Excel. Especially if you are
running Microsoft Excel 2010, some of your most versatile and comprehensive
reports can come from Excel spreadsheets. Because just about every entity will
perform a one-click export to Excel, this is an option for reporting on most of
your CRM data.

Task A Exporting a dynamic Excel PivotTable
A PivotTable is an object that can be added to an Excel spreadsheet that will
summarize your data independent of the original spreadsheet data. So, for
example, let’s say that your original data has three columns: Company, Name,
and State. The PivotTable could give a summary list of the number of compa-
nies in each state, broken down by state.

Outlook 2010/Internet Explorer:
1. Go to any list of records in

Microsoft Dynamics CRM.
2. Once you have a list of records

on the screen, click the Export to
Excel button in the Data group
of the ribbon.

3. You will have the option to
export a dynamic PivotTable.

4. Click the Export button.

Outlook 2003/2007:
1. Go to any list of records in

Microsoft Dynamics CRM. For
example, you could open a list of
contacts.

2. Once you have a list of records
on the screen, click the Export to
Excel button on the Records
menu.

3. You will have the option to
export a dynamic PivotTable.

4. Click the Export button.

You must have Microsoft Excel 2003,
2007, or 2010 installed on the local
computer to perform these tasks.
You must also have the Microsoft
Dynamics CRM Client for Outlook
installed to export a dynamic
PivotTable.
Click the Refresh from CRM button on
the toolbar to automatically update
the data in your PivotTable with live
data.
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Task B Exporting a dynamic Excel
spreadsheet

In the first task in this section, you exported a static Excel spreadsheet. In that
case, after the export had been performed, there was no live link between the
spreadsheet and Microsoft Excel. By exporting a dynamic spreadsheet, you get
the same spreadsheet, but it comes with a Refresh from CRM button on the
toolbar. Click that button, and live data from the CRM database is refreshed
into the spreadsheet.

Outlook 2010/Internet Explorer:
1. Go to any list of records in

Microsoft Dynamics CRM.
2. Once you have a list of records

on the screen, click the Export to
Excel button in the Data group
of the ribbon.

3. You will have the option to
export a dynamic spreadsheet.

4. Click the Export button.

Outlook 2003/2007:
1. Go to any list of records in

Microsoft Dynamics CRM. For
example, you could open a list of
contacts.

2. Once you have a list of records
on the screen, click the Export to
Excel button on the Records
menu.

3. You will have the option to
export a dynamic spreadsheet.

4. Click the Export button.

You must have Microsoft Excel 2003,
2007, or 2010 installed on the local
computer to perform these tasks.
The Microsoft Outlook client for
Microsoft Dynamics CRM must be
installed to refresh data.
This feature is only available for CRM
On-premise or CRM Online users that
have a local copy of the database
synchronizing to the server.
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Creating workflows and dialogs
Automated workflow is one of the most useful features in Microsoft Dynamics
CRM. Workflow is like a macro that sits in the background, watches for
changes or conditions within the database, and then creates records, modifies
things, or performs actions based on a pre-defined set of workflow steps.

For example, whenever a new lead is entered into the database for one of your
salespeople, workflow can be configured to automatically generate a reminder
e-mail to the salesperson and to create activities that aid in implementing your
business process. Workflows can be created by a system administrator and
applied to an entire organization, or they can be created by individuals to 
automate a personal business process.

Task A Workflow example: Forcing a new
follow-up activity when opportunities
are created

Workflow can change fields, create new records, send e-mails, and perform
many routine database tasks on an automated basis. In this example, you’ll see
how to create a workflow that will—every time a new opportunity is entered
into the database—create a follow-up activity phone call with the prospect.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings and then Processes.
2. On the Actions toolbar, click the New button.
3. Give your workflow a name, choose Opportunity as your entity, and select

Workflow as your category. Click OK.
4. Select the Scope for the Workflow.
5. In the Start When section, select the trigger for the workflow. The trigger is

the action (or inaction) that should cause the workflow to start.
6. Select the Scope for the Workflow.
7. In the Start When section, select the trigger for the Workflow, what action

(or inaction) should cause it to start.
8. On the Actions toolbar, click the Add Step drop-down and choose the

Create Record option.
9. Type a description for the workflow step. (It might be something like

Create Follow-up Call.)
10. In the Create drop-down, choose the Phone Call option.
11. Click the Set Properties button to configure the details of the call that will

be scheduled.
12. Click Save and Close.

The workflow will not run until it has
been activated. Highlight a workflow
and click the Activate button on the
Actions toolbar to activate it.
In this chapter, we cover only a very
small percentage of the functionality
available with workflow. Some pretty
ingenious applications of the
workflow feature are discussed in
CRM blogs. Do an internet search for
Microsoft Dynamics CRM Workflow
Blog (or something related), and
you’ll get a treasure trove of
information about the workflow
feature.
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Task B Workflow example: Creating an e-mail
when leads are created

In this book, you learn two very basic examples of workflows that can be
configured in Microsoft Dynamics CRM. Keep in mind, though, that you can
add multiple steps, wait conditions, child workflows, stages, and a lot more.
You could literally spend an entire week creating a complex workflow. In this
example, we’ll create a reminder e-mail that gets automatically sent to the
owner of a lead when the lead is created.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings and then Processes.
2. On the Actions toolbar, click the New button.
3. Give your workflow a name, choose Lead as your entity, and select

Workflow as your category type. Click OK.
4. On the Actions toolbar, click the Add Step drop-down and choose the

Send E-mail option.
5. Click the Set Properties button to configure the e-mail that will be sent.
6. In the From field, enter the sender contact.
7. Click your mouse in the To field. In the Form assistant on the right, make

sure Lead is selected in the Look for drop-down. In the drop-down below
that, choose the Owner option. Then click Add, and then OK. This will
add a field placeholder to show that the e-mail should be sent to the lead
owner, whoever that is.

8. Give the e-mail a subject and body, and click Save and Close.
9. Click Save and Close to save the workflow.

Remember, the workflow will not be
active until you activate it. Click the
Activate button to activate a
workflow.
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Task C Running an on-demand workflow
The workflows that we’ve created so far run automatically when a record is
changed, a status changes, a record is assigned, a record is deleted, or a record
attribute changes. However, you might have some workflows that you want 
to run on-demand. In these cases, you can highlight a record and force the
workflow to perform its steps on the record at that moment.

Outlook 2010/Internet Explorer:
1. Go to a list of records. For

example, you could click Sales in
the Navigation Pane and then
click Contacts to go to a list of
contact records.

2. In the Process group of the
ribbon, click the Run Workflow
button.

3. Select a workflow to run, and
click OK.

4. Click OK to confirm.

Outlook 2003/2007:
1. Go to a list of records. For

example, you could click Sales in
the Navigation Pane and then
click Contacts to go to a list of
contact records.

2. On the Contacts menu, click the
Run Workflow button.

3. Select a workflow to run, and
click OK.

4. Click OK to confirm.

When defining a workflow, make sure
the On Demand option is checked
under the Available to Run header.
Then, the workflow will be available
to run on-demand.
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Task D Creating a dialog
Think of a dialog as a wizard—the kind that you often see in Windows prod-
ucts. With a dialog, you can prompt the user to enter information about a
record and then the system will automatically fill in that information wherever
it belongs in CRM.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings and then Processes.
2. On the Actions toolbar, click the New button.
3. Give your dialog a name, choose an entity, and select Dialog as your cate-

gory type. Click OK.
4. Add your input arguments, variables, and steps to the dialog.
5. Click the Save & Close button and Activate when you are finished.

Dialogs are a very powerful feature
that can accommodate incredibly
complex scenarios. If this is a feature
that you are going to use, do an
internet search for Dynamics CRM
dialogs to find many blog postings
and articles about the dialog feature.
We could easily write a book on just
this topic.
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Creating entities
Entities are types of records in Microsoft Dynamics CRM. Contacts, activities,
cases, opportunities, campaigns, products, sales literature, and leads are all
examples of entities in Microsoft Dynamics CRM. By creating your own
custom entities, you can really extend the functionality of your database. 
Once the entities are created, you can create relationships between existing
entities and your new custom entities. Almost everything covered in this
chapter requires elevated security permissions in CRM.

Task A Creating a new entity
Let’s say you run a computer training business. You hold classes on a regular
basis. You want to be able to track student attendance for these classes in
CRM, but there is no obvious way to do this out of the box. By creating a new
custom entity for training classes, you can track information about each class,
and you can then link individual contacts to the classes they attend.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings, Customization, and then Customize

your solution.
2. Click the Entities option on the left.
3. On the Actions toolbar, click the New button.
4. Give your entity a display name, plural name, ownership level, and table

name.
5. Configure any other settings for the entity, like the areas (Workplace, Sales,

Marketing, etc.) that will display the entity. If you want to append notes
and activities to this entity, you may enable this capability at this point and
this point only.

6. Click Save and Close.

Once the new entity is created, you
will want to add fields and
relationships for the entity. You will
also want to customize the forms and
views used to enter information for
the forms. All of this is covered in this
chapter.
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Task B Publishing customizations
After adding an entity to the system, your database remains unchanged. You
need to publish the customizations, at which point all of your changes will
appear in the live database.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings, Customization, and then Customize

your solution.
2. Click the Entities option on the left.
3. Highlight the entity whose recent changes should be published to the live

database.
4. On the toolbar, click the Publish button.

Before publishing customizations, it
might be a good idea to make a
backup of your existing custom-
izations. In the Navigation Pane, click
Settings, Customization, and
Customize your Solution. Then click
the Export Customizations option.
On the toolbar, choose the Publish All
Customizations option to publish
every non-published customization.
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Customizing fields
You can create new fields in either a custom entity or one of the default enti-
ties—like contacts or leads. If you wanted to add a Customer Type drop-down
on the contact record, you’d add a new picklist field on the contact entity.

Task A Creating a new field for an entity
You can add a virtually unlimited number of fields for any entity. Need to
track additional information for your opportunities? Add new fields to track
that information. You can add the following types of fields:

■ Single Line of Text field can contain text, numbers, and symbols.

■ Option Set fields offer a drop-down menu of choices.

■ Two Options fields can have two possible choices, such as True/False or
Yes/No. Two Options fields can also be configured in your form
customization as check boxes or radio buttons.

■ Whole Number fields can only contain integers (numbers without a
decimal point).

■ Floating Point Number fields contain numbers with a decimal point.

■ Decimal Number fields have a fixed number of digits after the decimal
point.

■ Currency fields contain currency values.

■ Multiple Lines of Text fields are memo fields that can hold up to
100,000 characters.

■ Date and Time fields contain a date, time, or both.

■ Lookup fields point to another entity in the system and create a 1:N
relationship.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings, Customization, and then Customize

your solution.
2. Click the Entities option on the left.
3. Double-click the entity where you would like to create a new field.
4. On the left, click the Fields option.
5. From the Actions toolbar, click the New button.
6. Configure your new field.
7. Click Save and Close.

When adding a new field, check out
the Requirement Level field. You have
three options:
■ No Constraint—The field is not

required.
■ Business Required—Users cannot

save the entity until a value has
been added to the field.

■ Business Recommended—The field
is not required, but it will show
with a blue + to remind users that
they should enter information into
the field.
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Task B Creating a security-enabled field
You can put field level security levels on fields within the database. You can
then configure your system so that users can see certain fields based on a secu-
rity level. Credit card and social security numbers are obvious examples of
fields you would want to make security enabled.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings, Customization, and then Customize

your solution.
2. Click the Entities option on the left.
3. Double-click the entity where you would like to create a new field.
4. On the left, click the Fields option.
5. Double-click a field.
6. In the Field Security area, choose the Enabled Option.
7. Now, go back to the Customize your Solution area and choose Field

Security profiles.
8. Click the New button to create a role where you can define permissions for

this field (and others).

On any field, you can grant read,
update, or create rights to a user 
or team.
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Task C Creating a global option set
Option sets are drop-down fields. You might have a drop-down field that
appears multiple times in the database, and when this happens, you can create
a global option set so that changes made to one drop-down will show up in all
of the fields that share that drop-down.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings, Customization, and then Customize

your solution.
2. Click Option Sets on the left.
3. Click the new button on the Actions toolbar to create a new options set.
4. When you are adding a new field (see the previous lesson) you can now use

this global options set to populate the values of your drop-down.
5. Click the Save and Close button.
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Customizing forms and views
After you have added a new field for an entity, you’ll want to make sure it
displays as a field on the forms and views. When you double-click a contact, a
screen appears that lets you enter information about the contact. That screen is
called a form. In the Navigation Pane, when you click Sales and then Contacts,
the resulting spreadsheet-like list of contacts is called a view.

Task A Editing the form for an entity
The form is the screen that appears when you are editing information for an
entity. Double-click a contact, and the form for that contact appears. If you
add a new field for an entity, it doesn’t appear on the form until you add it
manually.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings, Customization, and then Customize

your solution.
2. Click the Entities option on the left.
3. Double-click the entity where you would like to add a field to the form.
4. On the left, click the Forms option.
5. Double-click the form you’d like to edit. For example, if you are adding

fields to the contact entity, you could double-click the form called Form,
which is the default application form.

6. Click the Add Fields button.
7. Check each of the fields you’d like to add to the form.
8. New fields appear at the bottom of the form. Highlight a field and click

the arrow buttons to move the field to a new spot on the form.
9. Click Save and Close.

Add new tabs to any form by clicking
the Add a Tab button.
You can use the IFRAME feature to
embed external content into a form.
You can create different forms for
different security roles.
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Task B Adding sub-grids to a form
The sub-grid shows a list of records associated with the record you are viewing.
So within a contact record, you might show a list of opportunities or activities.
Displaying them in a sub-grid puts them on the main page and prevents the
user from having to click on Activities or Opportunities on the left Navigation
Pane.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings, Customization, and then Customize

your solution.
2. Click the Entities option on the left.
3. Double-click the entity where you would like to add a sub-grid to the form.
4. On the left, click the Forms option.
5. Double-click the form you’d like to edit. For example, if you are adding

fields to the contact entity, you could double-click the form called Form,
which is the default application form.

6. On the Insert tab, in the Control group of the ribbon, click the Sub-Grid
button.

7. Give your sub-grid a name, configure your options, and select the type of
record that should be shown.

8. Click the Save & Close button.

Changes won’t appear until you
publish the entity.
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Task C Customizing the left navigation pane
for a form

The left Navigation Pane shows related activities, opportunities, quotes, orders,
invoices, etc. You may have some items on your Navigation Pane that aren’t in
use. For example, if you are not using the system for invoices, you might want
to remove invoices from the Navigation Pane.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click Settings, Customization, and then Customize

your solution.
2. Click the Entities option on the left.
3. Double-click the entity where you would like to customize the left naviga-

tion pane.
4. On the left, click the Forms option.
5. Double-click the form you’d like to edit. For example, if you are adding

fields to the contact entity, you could double-click the form called Form,
which is the default application form.

6. Double-click on the left Navigation Pane area.
7. Highlight an item (like Invoices) and then click the Remove button in the

Edit group of the ribbon.
8. Click the Save & Close button.

Remember to publish your
customizations.
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Task D Creating a system view
In a previous chapter you learned how to create a personal view. In this section
you’ll learn how to create a system view. A system view is like a personal view,
only it is available to all users once it is created.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings, Customization, and then Customize

your solution.
2. Click the Entities option on the left.
3. Double-click the entity where you would like to create a system view.
4. On the left, click the Views option.
5. Click the New button on the Actions toolbar.
6. Give your view a name and click OK.
7. Click Edit Filter Criteria to define a query that will determine which

records are shown in the view. Click Add Columns to add additional fields
for display in the view.

8. Click the Save & Close button.

System view will appear for all users,
so if you are creating a view that
should only be viewable by specific
users or a team, create a personal
view and share it instead.
You can save a copy of an existing
view to save time.
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Task E Enabling auditing
Auditing keeps track of changes made to fields within your CRM database. By
default, it’s turned off. You can choose to audit an entire entity or a specific
field within an entity.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings, System, and then Auditing.
2. Click the Global Audit Settings option to turn on auditing.
3. Click Entity and Field Audit Settings to enable audit tracking on entities or

fields.
4. Click Audit Log Management to manage the amount of space taken up by

your audit logs.

Use this field judiciously as it can
balloon the size of your database
pretty quickly.
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Creating users
Creating a user in an on-premise deployment follows a slightly different
process than the one outlined in this chapter. In an on-premise deployment,
Microsoft Dynamics CRM uses active directory users for authentication to the
database. In Microsoft Dynamics CRM Online, new users are authenticated
with the Windows Live ID. The instructions in this chapter are valid for
Microsoft Dynamics CRM Online.

Task A Adding a new user
Before you can add a new user, make sure that you have licensing to do so. If
you have a 10 user license to Microsoft Dynamics CRM, adding the 11th user
won’t work. Disabling a user, which is covered later in the chapter, will free up
a license.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Settings and then Administration.
2. Click the Users option.
3. In the Records group of the

ribbon, click the New button.
4. Choose a business unit and click

Next.
5. Select a security role and click

Next.
6. Enter the first name, last name,

and e-mail address for the user.
Click the Add button, followed
by the Next button.

7. Click the Create New Users
button.

Outlook 2003/2007:
1. In the Navigation Pane, click

Settings and then Administration.
2. Click the Users option.
3. In the Records group of the

ribbon, click the New button.
4. Choose a business unit and click

Next.
5. Select a security role and click

Next.
6. Enter the first name, last name,

and e-mail address for the user.
Click the Add button, followed
by the Next button.

7. Click the Create New Users
button.

Microsoft Dynamics CRM Online: Your
users will need to get a Windows Live
ID before they will be able to log into
the database.
Microsoft Dynamics CRM On-Premise:
Your users will need to be active users
in the domain to log in.
Microsoft Dynamics CRM Partner-
Hosted: Your hosting provider will
assign usernames and passwords for
the database.
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Task B Disabling a user record
If a user leaves the company, you can disable the user record. Disabling the user
will remove him or her from the list of active users, and it will free the license
for another active user. Once you disable a user, he or she will no longer be
able to access the system.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Settings and then
Administration.

2. Click the Users option.
3. Highlight the user that you’d like

to disable.
4. In the Records group of the

ribbon, click the Disable button.
5. Click OK to confirm.

Outlook 2003/2007:
1. In the Navigation Pane, click

Settings and then
Administration.

2. Click the Users option.
3. Highlight the user that you’d like

to disable.
4. On the Users menu, click the

Disable button.
5. Click OK to confirm.

After disabling a user record, any
workflows or system jobs (like imports
or duplicate checking jobs) owned by
this user will cease.
Users cannot be deleted. This
preserves the association with
historical activities.
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Task C Reassigning user information
If a salesperson leaves the company, you may want to reassign all of the former
employee’s information to the incoming user. In bulk, you can reassign all
record ownership from one user to another using this process.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings and then Administration.
2. Click the Users option.
3. Double-click the user whose records should be reassigned.
4. In the Actions group of the ribbon, choose the Reassign Records option.
5. Choose the Assign to another user option and choose the target user.
6. Click OK.

There is no easy way to undo this
action, so be careful!
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Security roles
Security roles define a level of access to specific entities and actions within the
database. A security role, for example, may allow users to delete contacts. It
may disallow deletion of contacts. The role might restrict deletion of contacts
to just contacts in the user’s business unit.

Task A Creating a security role
By creating custom security roles for each type of user in your database, 
you can very specifically restrict access to certain parts of the database. A
customer service agent, for example, might have a greater level of access to
cases, knowledge-base documents, and contracts. A salesperson might not be
able to even see knowledge-base documents.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings and then Administration.
2. Click the Security Roles option.
3. On the Actions toolbar, click the New button to create a new security role.
4. In the Details tab, give your security role a name, and assign it to a business

unit.
5. In each of the other tabs, specify the level of access that users assigned to

this security role should have.
6. For example, in the Core Records tab, click the Create option for Account

entities to allow creation of accounts.
7. Click Save and Close.

When assigning rights:
■ Click once to assign rights for

records owned by the user.
■ Click again to assign rights for

records owned by the business unit.
■ Click again (three times) to assign

rights for records owned by the
business units and also child
business units.

■ Click again (four times) to assign
rights for records owned by the
entire organization.
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Task B Assigning a security role to a user
The security role defines what a user can and cannot do in the database. Users
assigned a specific security role will be restricted by the limits of the security
role. So, if a security role does not allow deletion of notes, any users assigned to
the security role will not be able to delete notes.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings and then Administration.
2. Click the Users button.
3. Double-click a user.
4. On the left, click the Security Roles option.
5. In the Actions group of the ribbon, click the Manage Roles button.
6. Place a checkmark next to each role that should be assigned to this user.
7. Click OK, and then Save and Close.

Since multiple security roles can be
added to any user, the least limiting
security role permissions will override.
So, let’s say a user is assigned to two
security roles. One security role does
not allow deletion of contacts, but the
other does. The user will be able to
delete contacts.
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CRM Online users
Windows Live ID is the authentication system for CRM Online users. Instead
of purchasing fixed-cost licenses, you will buy a number of users at a monthly
fee. For more information, go to crm.dynamics.com.

Task A Managing licensing and purchased
storage

Adding additional available licenses and additional gigabytes of storage to your
CRM Online account is done within a central license area within CRM
Online. You will likely need to be the billing administrator on your account to
do any of this. If you run into problems, call 877-CRM-CHOICE, option 2.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings, Administration, and then

Subscription Management.
2. Here you’ll have the option to add licenses or additional storage.

For billing related questions, call 877-
CRM-CHOICE, option 2.
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Task B Creating a Windows Live ID
CRM Online uses a Windows Live ID for user authentication. Windows Live
ID is the cross Microsoft authentication mechanism. You should have a
Windows Live ID before you sign up for CRM online.

Internet Explorer:
1. Go to https://signup.live.com.
2. Follow the on-screen instructions to create a Windows Live ID.

If you have a Hotmail account, you
can use this as your Windows Live ID.
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Working with business units
In Microsoft Dynamics CRM, your organization is made up of business units.
Within each business unit, you can define teams of users. Your permissions
may be limited to records owned within your business unit. For example, you
may have security permissions to delete contacts across the entire organization.
You might be restricted to deleting contacts owned by users within your busi-
ness unit, or you might only be able to delete contacts that you own.

Task A Creating a business unit
A business unit is a group of users within your company that work on a
common objective. General Motors is a large company, and business units
within that company might be Pontiac, GMC Trucks, Cadillac, etc.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings and then Administration.
2. Click the Business Units option.
3. On the Actions toolbar, click the New button.
4. In the Name field, enter the name of your business unit.
5. If this is a sub-unit of an existing business unit, specify the parent business

unit in the Parent Business field.
6. Click Save and Close.

Once a business unit has been
created, it cannot be modified or
deleted. If you create a business unit,
be sure to spell it properly, and make
sure the capitalization is consistent. If
you make a mistake, you can disable
the business unit and start again.
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Task B Changing settings for an existing
business unit

You can change just about any business unit setting, except for the name. You
can change users, teams, facilities/equipment, and resource groups assigned to
any business unit. You can also change field information—like the address—
for an existing business unit.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings and then Administration.
2. Click the Business Units option.
3. Double-click the business unit you would like to edit.
4. Change any field information for the group.
5. On the left, click the Users, Business Units, Teams, Facilities/Equipment,

or Resource Groups buttons to change entities that are associated with the
business unit.

6. Click Save and Close to exit.

To change the parent business unit for
a business unit, click the Change
Parent Business option from the
Actions drop-down.
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Task C Disabling a business unit
You cannot delete a business unit, but you can disable it. Disabling a business
unit will prevent any users assigned to that business unit from logging into
your database. If you work in a large organization, and you sell a business unit
to a competitor, you’d disable the business unit within Microsoft Dynamics
CRM.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings and then Administration.
2. Click the Business Units option.
3. Double-click the business unit you would like to disable.
4. From the Actions drop-down, choose the Disable option.
5. Click OK.

Any sub-business unit under a
business unit that you disable will
also be disabled.
To enable a disabled business unit,
choose the Enable option from the
Actions drop-down.
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Task D Changing the business unit for a user
If a user transfers from one business unit to another, you can switch the associ-
ated business unit for the user. Changing a user’s business unit may change the
data that the user can access.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings and then Administration.
2. Click the Business Units option.
3. Double-click the business unit for the user.
4. On the left, click the Users option.
5. Highlight the user (or users) whose business unit should be changed.
6. From the More Actions drop-down, choose the Change Business Unit

option.
7. Select a new business unit and click OK.

This procedure can also be used to
reassign facilities or equipment to a
new business unit. In step 4, click the
Facilities/Equipment option instead of
the Users option to reassign facilities
and equipment.
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Working with teams
Teams are groups of users. They are most commonly used when sharing
records. Whenever you share a record, you have the option of sharing that
record with a user or a team.

Task A Creating a new team
Teams are assigned to a specific business unit. A team can contain as many
users as you have in the database, and removing a user from a team will remove
that user’s access to any records shared only with the team.

Outlook 2010/Internet Explorer:
1. In the Navigation Pane, click

Settings and then
Administration.

2. On the Teams tab, in the Records
group of the ribbon, click the
New button.

3. Give your team a name and busi-
ness unit.

4. Click the Save button. (This is
necessary to add users.)

5. Go to the next page for instruc-
tions on how to add users to a
team.

Outlook 2003/2007:
1. In the Navigation Pane, click

Settings and then
Administration.

2. On the Teams menu, click the
New button.

3. Give your team a name and busi-
ness unit.

4. Click the Save button. (This is
necessary to add users.)

5. Go to the next page for instruc-
tions on how to add users to a
team.

It’s a good idea to add a description
for your teams, especially if you are
working in a database with a large
number of users. This way, other
administrators of your database will
know the purpose for adding the
team.
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Task B Changing team membership
As employees come and go, and as they transfer to different positions within
your company, you will likely need to update team membership. If you remove
a user from a team and add the user to another team, any access privileges the
user had from the first team will be removed, and new access levels will be
added for records shared with the second team.

Outlook 2003/2007/2010/Internet Explorer:
1. In the Navigation Pane, click Settings and then Administration.
2. Click the Teams option.
3. Double-click the team whose team membership should be changed.
4. On the left, click the Members option.
5. To remove a user from the team, highlight the user. Then, in the Records

group of the ribbon, click the Delete button.
6. To add a new member to the team, click the Add Members option in the

Records group of the ribbon.

On the left, click the Workflow option
to see any workflows related to the
team.
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Sharing records with others
When you share records with other users, teams, or business units, you grant
them specific levels of access to the record. The following permissions can be
granted on most records:

■ Read ■ Append ■ Share ■ Delete

■ Write ■ Append To ■ Assign

Task A Sharing a record with another CRM
user, team, or business unit

When you grant access to a record, the user, team, or business unit that has
been granted access will have the specified level of access to that record. The
user, team, or business unit may also be granted access to associated records.

Outlook 2010/Internet Explorer:
1. Go to a list of records. For

example, you could click Sales
and then Contacts on the
Navigation Pane to get to the list
of contacts.

2. Highlight a record.
3. On the Contacts tab, in the

Collaborate group of the ribbon,
click the Sharing button.

4. On the left, click the Add
User/Team option.

5. In the Look for drop-down,
select to look for either a user or
team. In the Search field, type
the name of the user or team
you’d like to find.

6. Click the Search button to show
available records.

7. Double-click the user or team
from the list of available records.

8. Click OK.
9. Set the permissions for the user

you added to the access list.
Options are: Read, Write, Delete,
Append, Assign, Share, and
more—depending on the type of
record you are sharing.

10. Click OK.

Outlook 2003/2007:
1. Go to a list of records. For

example, you could click Sales
and then Contacts on the
Navigation Pane to get to the list
of contacts.

2. Highlight a record.
3. On the Contacts menu, click the

Sharing button.
4. On the left, click the Add

User/Team option.
5. In the Look for drop-down,

select to look for either a user or
team. In the Search field, type
the name of the user or team
you’d like to find.

6. Click the Search button to show
available records.

7. Double-click the user or team
from the list of available records.

8. Click OK.
9. Set the permissions for the user

you added to the access list.
Options are: Read, Write, Delete,
Append, Assign, Share, and
more—depending on the type of
record you are sharing.

10. Click OK.

To share a record with others, you
must be:
■ The owner of the record or
■ You must have been granted Share

access by the owner of the record
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Task B Checking your access for a record
If you are on a record, you can check your level of access for that record. This
procedure works on most records—like contacts, opportunities, accounts,
cases, etc.

Outlook 2003/2007/2010/Internet Explorer:
1. Go to a list of records. For example, you could click Sales and then

Contacts on the Navigation Pane to get to the list of contacts.
2. Double-click a record to open it for editing.
3. Click the File tab.
4. Choose the Properties option.
5. Your permission level will appear for the record.

If you want to have a greater level of
access to the field, you will need to
contact the owner of the record.
When editing a record, go to the
Administration form section to see 
the owner of the record.



Chapter 21 Sharing and Assigning Records

210

Assigning records to others
Assigning records is different than sharing records in that, after assigning a
record, the record ownership changes to the reassigned user. Once you no
longer own the record, you may have limited rights to the record, even though
you were the original owner.

Task A Assigning a record to another CRM
user, team, or business unit

To reassign a record to another user or team, you must either be the owner of
the record or you must have the Assign permission for the record.

Outlook 2003/2007/2010/Internet Explorer:
1. Go to a list of records. For example, you could click Sales and then

Contacts on the Navigation Pane to get to the list of contacts.
2. Double-click the record you’d like to assign.
3. In the Collaborate group of the ribbon, click the Assign button.
4. Click the Lookup button to find a user.
5. Select the user for reassignment and click OK.
6. Click OK.

When editing a record, you can also
reassign ownership by changing the
Owner field. In the Contact record, for
example, that field is on the
Administration form section.
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Task B Sharing or assigning multiple records
If you want to share or assign multiple records, you can do so from most lists
of records. Sharing multiple records will grant the user(s) access to all records,
and assigning multiple records will change the owner field for all selected
records.

Outlook 2010/Internet Explorer:
1. Go to a list of records. For

example, you could click Sales
and then Contacts on the
Navigation Pane to get to the list
of contacts.

2. Highlight the records you’d like
to share or assign.

3. In the Collaborate group of the
ribbon, click the Share button.

4. To re-assign multiple records,
click the Assign button.

Outlook 2003/2007:
1. Go to a list of records. For

example, you could click Sales
and then Contacts on the
Navigation Pane to get to the list
of contacts.

2. Highlight the records you’d like
to share or assign.

3. In the Record menu, click the
Share button.

4. To re-assign multiple records,
click the Assign button.

You can only assign or share multiple
records if you have sufficient
permissions to assign or share all
highlighted records.
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associating contacts with, 22
converting lead to, 7
Outlook, 60
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contract, 133
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Activities list view, 88
adding to campaign, 98
appointment, 90, 92
campaign, 99
closing, 93
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Outlook, 63
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submitting for approval, 147
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workflow, 174–176

B
blacklisting, 126
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bulk record deletion, 15
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user, 203

213



Index

214

C
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service
filter, 155
scheduling activities and
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searching the, 156
services, resources, and work

hours, 160–162
viewing, 154

tracking Outlook appointment, 63
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to, 100
adding planning activity to, 98
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quick, 101, 127
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closing a, 105
converting to lead or opportu-

nity, 104
creating new, 102
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case, 141
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to, 143
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cancellation, 141
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creating new, 138
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157–159
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entering notes for, 139
finding, 139
marking as resolved, 141
neglected case report, 144
reactivating, 142

chart
dashboard, 50, 53
viewing source records in, 53

closed record, 20
closing

activities, 93
campaign response, 105
opportunity, 79

color, record, 23
columns, in search results, 38
comma separated value (CSV) file,

164
comment, 149
competitors

associating opportunity with, 81
creating list of, 80

conditional formatting feature, 23
connections, between records,

27–29
contact

associated with account, 22
converting lead to, 7
Outlook, 59

contract
activation, 133
cancellation, 134
contract line, 132
creating new, 131
expired, 135
invoicing, 133
renewal, 135
template, 130

converting
appointment to opportunity, 94
lead, 7
Outlook e-mail, 68–69

copying membership, 112
CoreMotives e-mail marketing

service, 126
Create Quick Campaign button, 38
CSV (comma separated value) file,

164

customization
field, 182–184
forms, 184–187
publishing, 181
Quick Find feature, 33
system view, 188

D
dashboard

charts and views, 50, 53
creating new, 46–47
drill down data, 52
editing, 48
enlarging, 51
layout, 48
personal, 47
shared, 49
source data, 53
switching between, 51
system, 46
uses for, 46

deactivation
marketing list, 110
record, 14

deleting
case, 141
contract template, 130
lead, 4
record, 14–15, 113
records associated with import,

168
dialog, 177
disabling

business unit, 202
user record, 193

disqualifying lead, 8
drill down data, 52
duplicate record

finding, 42
merging, 44
viewing, 43
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duplicating campaign response,
103

dynamic Excel PivotTable, 171
dynamic Excel spreadsheet, 172
dynamic marketing list, 109

E
editing

dashboard, 48
opportunity, 78
record, 13

e-mail
CoreMotives marketing service,

126
Outlook

attachment, 67
converting, 68–69
sending, 64–67
template-based, 66, 124
tracking incoming, 65
tracking new, 64

sending
to multiple recipients,

126–127
template-based, 124
viewing history of e-mail sent,

125
workflow, 128

E-mail KB Article button, 143
entity

creating new, 180–181
creating new field for, 182
editing form for, 185
publishing customizations for, 181

envelope, 119
Excel

exporting Advanced Find data to,
38

exporting to, 169–170
opportunity report, 84
PivotTable, 171
spreadsheet, 172

exporting
Advanced Find data to Excel, 38
to Excel, 169–170
PivotTable, 171
spreadsheet, 172

F
field

Business Recommended, 182
Business Required, 182
customization, 182–184
entity, 182
global option set, 184
grouping a list by, 36
No Constraint, 182
security-enabled, 183

filter
adding, 34
Outlook, 58
saving as new view, 34
service calendar, 155

finding
Advanced Find feature

data, changing columns that
show in, 38

data, exporting to Excel, 38
finding records, 18
how to use, 37
personal view, 37–38

case, 139
duplicate record, 42–44
lead, 5
Quick Find feature, 132–133
record, 18, 32–33

follow-up activity, 174
font, 23
format, record, 21
forms

customization, 184–187
for entity, 185
left navigation pane customiza-

tion, 187
sub-grids, 186

G
global option fields, 184
goal

“amount” goal metric, 72
“count” goal metric, 73
individual, 75
query, 74
revenue goal metric, 72
rollup query, 74

grouping lists by field, 36

I
IFRAME feature, 185
Import Data Wizard

deleting records associated with
import, 168

failed import records, 167
importing lead, 3
importing multiple files, 165
importing text file, 164
verifying import job, 166

installation, Outlook plug-in, 56
invoice, 133

K
knowledge base article

assigning to case, 143
publishing, 148

L
label, 118
layout, dashboard, 48
lead

converting campaign response to,
104

converting to account, contact, or
opportunity, 7

creating new, 2
deleting, 4
disqualifying a, 8
finding a, 5
importing list of, 3
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My Open Leads, 6
in Outlook, 61
qualifying, 7–9
reactivating, 9
recommended field, 2
required field, 2
viewing, 5–6
views, switching between, 6

library, article, 146, 150
licensing, 197
list of leads, 3

M
mail merge

envelope, 119
execution, 117
label, 118
selecting recipients for, 116
template, 120–121

Mail Merge button, 38
marketing list

activation/deactivation, 110
adding record to, 111
adding to campaign, 100
copying membership for, 112
creating new, 108–109
dynamic, 109
membership, 111–113
removing record from, 113
static, 108

membership
marketing list, 111–113
team, 205

merging duplicate record, 44
My Open Leads, 6

N
neglected case report, 144
No Constraint field, 182
note

adding to record, 16
entering for case, 139

O
offline, 57
on-demand workflow, 176
online, 57
online user, 197–198
opportunity

adding products to, 77
closing a, 79
converting appointment to, 94
converting campaign response to,

104
converting e-mail to, 68
converting lead to, 7
creating new, 76
creating relationship between

competitor and, 81
editing, 78

opportunity report, 84–85
organization mail merge template,

121
Outlook

accounts, 60
appointment, 63
contacts, 59
CRM accounts in, 60
CRM synchronization, 57–58
e-mail

attachment, 67
converting, 68–69
sending, 64–67
template-based, 66
tracking incoming, 65
tracking new, 64

filter, 58
leads in, 61
plugin, installing, 56
scheduling activities within,

62–63
tracking tasks in, 62

ownership, shared record, 24

P
parent business unit, 201
permission

security-enabled fields, 183
shared record, 26, 208

personal dashboard, 47
personal goal, 75
personal mail merge template, 120
personal view, 37–38
pinning a view, 35
pivot table, 84, 171
planning activity, 98
plug-in, Outlook, 56
plus sign (+), 2
printing

articles, 151
envelope, 119
label, 118
record, 21

products
adding to campaign, 100
adding to opportunity, 77

prospect. See lead
publishing

articles, 148
customization, 181

Q
qualifying a lead, 7–9
query, 74
queue, 139
quick campaign

creating new, 101
sending e-mail to multiple recipi-

ents through, 127
Quick Find feature, 32–33
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R
reactivating

case, 142
lead, 9

record
access, 209
adding attachments for, 17
adding notes for, 16
adding to marketing list, 111
assigning, 210–211
bulk deletion, 15
closed, 20
color, font, and size, 23
conditional formatting feature, 23
connections between, 27–29
contacts associated with, 22
creating new, 12
deactivation, 14
deleting, 14–15
duplicate, 42–44
editing, 13
finding a, 18, 32–33
format, 21
going to specific, 13
grouping, 36
printing, 21
removing from marketing list, 113
shared

assigning, 210
assigning to user or team,

24–25
checking access for, 209
multiple, 211
ownership, 24
permission, 26, 208

viewing, 18–23
viewing activities linked with, 89
viewing inactive, 14
viewing pending and closed activi-

ties for, 20
views, switching between, 19

recurring appointment, 92
red asterisk (*), 2
renewal, contract, 135
report, 84–85
Report Wizard, 85
resolved case, 141
resource

assigning to service, 161
work hours, 162

response, campaign
closing a, 105
converting to lead or opportunity,

104
creating new, 102
duplicating, 103

revenue goal metric, 72
rights, security roles, 195–196
rollup query, 74

S
sales literature

adding, 82
attaching to e-mail, 67
viewing, 83

saving filter as new view, 34
searching

articles library, 150
duplicate records, 42–44
finding a lead, 5
finding a record, 18
Quick Find feature, 32–33
service calendar, 156

security roles, 195–196
security-enabled field, 183
Send Direct E-mail button, 124
sending e-mail

to multiple recipients, 126–127
template-based, 124
viewing history of e-mail sent, 125

service calendar
activities and appointments

associating with case, 159
rescheduling, 158
scheduling new, 158

filter, 155
searching the, 156
service

assigning resources to, 161
creating, 160
work hours, 162

viewing, 154
shared dashboard, 49
shared record

assigning, 210
assigning to user or team, 24–25
checking access for, 209
multiple, 211
ownership, 24
permission, 26, 208

spreadsheet, 171
static marketing list, 108
storage, 197
sub-business unit, 202
sub-grids, 186
switching

between dashboard, 51
between lead view, 6
between record view, 19

synchronization, Outlook/CRM,
57–58

system dashboard, 46
system view, 188

T
tasks

creating new, 91
Outlook, 62

team
creating new, 204
description, 204
membership, 205
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template
campaign, 97
contract, 130
mail merge, 120–121
organization, 121
personal, 120

template-based e-mail, 66, 124
text file, importing, 164

U
user

adding new, 192
business unit, 203
disabling, 193
online, 197–198
reassigning user information, 194
security roles, 195–196
Windows Live ID, 197–198

V
view

dashboard, 50
filtering a, 34
personal, 37–38
pinning a, 35
system, 188

viewing
activities, 88–89
duplicate record, 43
inactive record, 14
lead, 5–6
record, 18–23
sales literature, 83
service calendar, 154

W
Windows Live ID, 197–198
Word icon, 117
work hours, 162
workflow

automated processes, 174–176
creating e-mail when leads are

created, 175
follow-up activity when opportu-

nities are created, 174
on-demand, 176

workflow e-mail, 128
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